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Preface 
This user manual intends to help you know about WhizAI and its functionalities; it gives you a broad 

overview of the out-of-the-box features and functions WhizAI along with the necessary information and 

instructions about using WhizAI through different interfaces.  
 

You can refer to the following sections to get started with WhizAI: 
●  

● Getting Started 
● Understanding WhizAI User Interface 
● Using WhizAI on the web 

 

Intended Audience 

This guide is intended primarily for the following users: 

● Pilot team who performs UAT to navigate through WhizAI  

● Trainers to onboard new users on WhizAI and for training purposes 

● New or existing business users as a reference manual 

Related Documents 

Along with this user manual, you can refer to the following documents: 

● Administrator’s Guide 

● NLP Guide 

● ExplAIn Guide  

● QRG Pinboards 

● QRG Product 

Contacting WhizAI 

For any support, you can reach to WhizAI support team in any of the following ways: 

● Website: https://whiz.ai  

● Email: support@whiz.ai

https://whiz.ai/
mailto:support@whiz.ai
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Introduction 

WhizAI is the first and only generative AI-powered analytics platform purpose-built for life sciences and 

healthcare. Fast, easy, and scalable, WhizAI is transforming analytics with self-service analytics, zero-code 

dynamic dashboarding, and automated insights generation making WhizAI the trusted partner of choice at 

top global pharma and healthcare companies.  

 

Learn more at www.whiz.ai 

  

http://www.whiz.ai/
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Getting Started   

This chapter provides information that you need to know about the supported environment for WhizAI, thus 

you can get started with WhizAI your system environment. This section details the following: 

 

● Supported browsers 

● Supported channels 

● Logging in to WhizAI 

● Logging out from WhizAI  

Supported browsers 

WhizAI supports the following browsers:  
 

● Google Chrome, v130 & above 

● Mozilla Firefox, v130 & above 

● Microsoft Edge, v130 & above (Windows); v130 & above (MacOS) 

● Safari V15 & above (MacOS) 

IPAD/Tablet Support 

WhizAI supports the following browsers: 
 

● Google Chrome, v130 & above 

● Safari V15 & above (MacOS) 

 Note! For Google Chrome and Safari, WhizAI has voice support as a feature. 

Supported channels 

You can access WhizAI it from the following channels: 
 

● Web: You can access WhizAI through web browsers. Refer to the list of supported browsers. Also, 

for more information, see Using WhizAI on the web. 

● Collaboration Tools (MS Teams, SMS, Skype, Slack, and so on) 

● MS Teams: You can access WhizAI through your Microsoft Team interface. 

● SMS: You can interact with WhizAI by sending an SMS through your registered mobile number. You 

need to send a separate SMS for each question and each option number in the response. 
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● Skype: You can interact with WhizAI by sending messages through your Skype account registered in 

WhizAI. 

● Slack: You can interact with WhizAI by sending messages through your Slack account registered in 

WhizAI. 

Logging in to WhizAI 

1. Open any of the supported browsers and enter the URL for WhizAI. The login page appears: 

 

2. Enter your login credentials and click Sign In to log in WhizAI. 

Logging out from the WhizAI 

1. From the top right corner of WhizAI Explorer, click the Profile icon. 

2. Click Logout. You log out WhizAI. 

Understanding WhizAI User Interface 

This chapter explains different sections of WhizAI platform’s user interface. 

● Explorer 

● Top navigation 

● Conversation box 

● Response box 

● Pinboards 

● Profile Menu 
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Explorer 

Explorer is the home page that you see after Logging in to WhizAI platform. It is designed and developed 

as a clean and user-friendly interface so that you can easily navigate and access the required functionality. 

 

 
 

The following table explains the different sections of the Explorer: 
 

Callout  Description 

1 Response area: In this area, you can see the responses to the questions you ask WhizAI. 

2 
Conversation box: In this area, you can enter your questions and view the filters that WhizAI 
applies to the response. For more information, For more information, see the "Info Model” 
section in the conversation box. 

3 
Board panel: This panel shows the different cards that are pinned to Current pinboard. For more 
information, see Pinboards. 

4 
Model Info: Click the Model Info to view the list of metrics, dimensions, and reports in the 
selected data model 

5 
Notification: Click the bell icon to view the Notification and Alerts generated in the WhizAI 
platform. 
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Callout  Description 

6 
Profile: Click the profile icon of the logged-in user to access Profile Settings, Get Started, About 
us, and to Logout of WhizAI. 

7 
All Pins: Click this icon to open the main boards panel where you can view all the pinboards and 
cards. Also, you can perform the board settings and share boards. 

8 Expand/ Collapse: The icon to expand the response area by collapsing the board panel. 

9 

Top Navigation Pane: You can click any of the header-level navigation options for easy 
transitioning between different areas of the product. The top header navigation pane is always 
visible no matter where you are in the product. You can effortlessly access the different areas 
within the product.  

10 

Example Conversations panel: You can click on any predefined user queries from this panel to 
start with your analysis. When you choose a query, the system resets the context and generates a 
corresponding response in the Explorer. Administrators can configure whether these example 
questions display on the Explorer or Model Info panel. 

Top Navigation options 

You can access the following areas of the product from the top navigation: 

● Explorer - navigates to WhizAI Explorer with the latest response at the top. 

● Pinboards - navigates to the main pinboard’s panel. 

 Note! When you click Pinboards from the top navigation, you land on the pinboard that is pre-
configured for you by your system administrator. (known as the landing page). However, if such a board 
is not pre-configured, then the first board existing under Favorites opens. 

● Alerts – navigates to the Alerts page. You can manage the alerts from here. 

● Explain – navigates to the Explain Workbench to derive meaningful insights from the data you want 

to analyze. 

● Admin – opens the Admin dashboard. 

● Help – navigates to the WhizAI support center. 

 Tip! WhizAI shows a warning message when you attempt to navigate to any area with any pending 
changes. This warning message serves as a reminder to review and save your changes before 
proceeding, thus preventing loss of unsaved work and ensures data integrity. 
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Conversation box 
 

 
 

The following table explains the context bar options: 
 

Context  Description 

Question area The area where you can enter your question. For more information, see Asking a 
question 

Context bar (filter) The gray color bar shows the filters that WhizAI are identified in your question. The 
filters that appear are based on the question that you enter. You can remove these 
filters by clicking the cross (x) icon for each filter condition. 

There are the following types of filters: 

● Default: Time and Metric are the default filters. You cannot remove these filters. 

● Context: The context is set due to reference to metadata entities or metrics used in the 
question asked by the user. 

● Authorization: Set due to user authorization. You cannot remove this filter.  

It shows the data to which you have limited access. Knowing this detail helps you query 
the data accordingly.  
You can see (maximum) twelve entities in this list. If you have access to more than 12 
entities, WhizAI shows the 12 entities “+x”, where “x” indicates the number of entities. 
For example, if you have access to fourteen entities, the Authorization icon will show you 
the list of 12 entities (+2). 
For more information, see Context. 

Model Info & 
Suggested Queries 

Click the Model Info button to view the list of metrics, dimensions, and reports in the 

selected data model. You can see a + icon before the list of dimensions and metrics. If 

you click the + icon, WhizAI expands all the metrics/dimensions, and you can see the 

hierarchical data under it. 
 

For each metric, you can see a list of available computations. This information is useful 
when you add these computations to card filters. If you hover the cursor over the 
respective metric or dimension, WhizAI shows more information about the metric or 
dimension in a tooltip.  
 

Within the info model, you can see a section that shows the suggested queries for the 
selected data model. You can click these queries, as required, to view the 
corresponding response. 
 

Also, this ‘Info’ page shows a ‘Reports’ section that contains all the available reports for 
the data model. Click any of the report to generate it. All the base metrics for the 
selected data model are displayed.  
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Context  Description 

If you click any dimension, WhizAI shows you the values for that dimension. You can 
expand the metrics to view the applicable computations. Within the info page, you can 
also see a search bar that helps you filter any metric, dimension, or report, as required.  
 

Tip! If you hover the cursor over any metric, you can see a short description of the 
metric.  
 

The ‘Info’ page also includes categories that are defined according to business areas. 
You can click a business area category to view the corresponding metrics, dimensions, 
and reports applicable to that business area. 

Reset Context 

Click  icon to reset the context that is established from your previous question. 

After you click Reset, the Context Reset message appears in the Response box. 

Voice Input 

Click  icon and hold it to provide voice input for specifying the question instead of 
typing. 

For more information, see Using Voice to Ask the question. 

Slicers You can capture the context set in the conversation box and create a slicer around it. 
You can see the slicer’s icon in the conversation box. 
 

If you click  this icon, WhizAI shows you a list of existing slicers under the Slicers tab. 
 

If you select a slicer from the list, WhizAI applies it to the context thereby replacing the 
existing context. To create a slicer from the conversation box: 

Click Create new slicer + under the Slicers tab in the Slicer and Cohort icon. WhizAI 
shows the Create slicer dialog. The filter values you see in the Create Slicer dialog are 
picked up from the context set in the Conversation box.  

You can add more filters or remove the existing filters, as required.  
Enter a name for the slicer, as required, and click Save. WhizAI creates the slicer and 
adds it to the list of existing slicers. 

Cohorts Cohorts allows you to group values of a dimension that share the same characteristics to 
analyze your patient and customer data. 
 

If you click Slicer and Cohort icon  , WhizAI displays a list of existing slicers under the 
tabs All, My lists and Shared with me in the Cohorts tab. WhizAI shows the Create 
cohort dialog.  
 
Click Create new slicer + under the Cohorts tab in the Slicer and Cohort icon. the box. 
WhizAI shows the Create slicer dialog. The dimension values that share the same 
characteristics are grouped together having single target dimension. The condition is 
built using AND logic between one or more conditions with In and Not In operators to 
select the values.  
 
As an owner or editor, WhizAI allows you to, Copy, Share, Edit, or Delete the cohorts 
from the explorer or pinboard. A system notification is sent to all the recipients if the 
cohort is shared or unshared by the cohort owner.  
Note! To update the target dimension option is not allowed 
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Context  Description 

You can create cohorts and use them on Explorer using NLQs as well as on Pinboard by 
adding as filters. 

Authorization Click the Authorization icon  to view a list of all the default geographies, metrics, and 
dimensions for which you have limited access.  
 

WhizAI allows to set default values for Market and Product as well. 

Smart search 
Click on the Smart Search icon on the conversation box on the WhizAI Explorer. 
Smart Search allows you to search and add entities to your queries. The smart search 
can be configured from the content management tab under the Admin console section. 

Data Model Shows the data models configured for you 

Reference Date 
Click the reference date icon  to select a date, as required, and query data for the 
metrics applicable until the selected date.  
A reference date is a specific date or time period chosen to filter and display relevant 
data on pinboards. It helps ensure that only pertinent information is shown when you 
deal with multiple data sources.  
You can set reference dates to align data representation with your analysis needs.  
 

For example, if you select sales_nbrx as a data source, it will have data from 2022-01-01 
to 2022-05-06 
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Profile Menu 

The Profile icon shows the following options: 

 

 
 

● Profile Settings - You can change the password, select the preferred language, and select the 
default landing page option from the User Settings page. By default, the landing page and English 
language are set during user creation. However, WhizAI offers the flexibility to override the default 
selection using the Profile Settings. 

● About us - allows you to access: 

o WhizAI Privacy Policy 
o WhizAI Terms of Service 
o Release version information 
o Help 

● What’s new - access the latest WhizAI features and tips. 
 

● Get started - information about the features and options on WhizAI Explorer. This option is visible 
only when you are on the Explorer or the Pinboards page. 
 

● Logout - Logs out of the WhizAI application. 
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• Creating a Board 

Response Options 

In every response, you can see options (as shown in the following figure) to perform additional actions on 

that response other than changing the response layout and format. 

 

 
 

The following table explains the response options and their description: 
 

Callout 
Response 
Option 

Description 

1 Pin Message Pins the response message to the selected pinboard. 

2 Expand Pops-up the response in its original size so that you can view the details. 
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Callout 
Response 
Option 

Description 

3 More actions 

Displays more actions: 

● Average: Calculates the National/ District/ Region/ Territory level average 
values (You can see this option in a tabular response, only). 

● Download data: Downloads the data of the response to a CSV file. 
● Download image: Download the response as an image in PNG format. 
● Share: Opens the Share response with dialog. You can select a user or a 

user group, as required, and share the response. 

4 Info 

Business Data Descriptions are displayed on the user interface when you hover 
the cursor on a dimension/metric on the Info page or when you click on the 

Info option  on the response. 

5 Alerts 

WhizAI allows you to define the scope and filters for creating alerts. These 
alerts can be set for each data refresh. You can set multiple conditions and 
create alerts based on the data points, entity or metric comparisons, and 
dimensions. Also, you can subscribe or unsubscribe from alerts and choose to 
receive the alert notifications through the web or email, depending on your 
preferences. 

6 Narratives 
WhizAI provides text narratives from your data. These narratives prove to help 
derive meaningful insights from the data shown in the response. They equip 
you to make informed decisions. 

7 ExplAIn 

WhizAI offers the ExplAIn Workbench UI to: 

● Find key driving factors for a given business metric  
● Detect Anomalies in a trend 
● Derive futuristic trends 

 

Data Controls 

The Data Controls option allows you to change the time granularity (day, week, month, quarter, year) 

directly on applicable charts and tables, enhancing flexibility and user experience. This feature enables you 

to toggle between different time granularities without firing new queries and also allow pinboard owners 

and editors to save changes on the pinboard. 

 

How to use Data Control? 
Let us ask the following query, show me TRx weekly 
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Follow the steps to use Data Control 

1. Click Data Controls. A list of Time Interval options are displayed. 

 
 

2. Select the time interval bucket. The visualization reflects the time granularity based on the selected 
period. 
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 Note! Changing the time granularity reflects for all the applicable visuals even when you 
switch to different visuals   i.e. if granularity is changed from Week to Quarter on trendline, then 
switching to a table OR bar chart retains that changed Quarterly granularity. 

 

 

Response box 

The Response box is the area where WhizAI respond to all your questions. WhizAI interactively displays 

responses so that you can easily get the information that you are looking for. If required, you can drill down 

the response and retrieve more details.  
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Being AI-enabled, WhizAI not only displays a response but also analyzes the best visualization suitable for 

that response. In visualization, WhizAI decides whether to display the response in a table format, chart 

format, or a simple message format. Each response provides additional visualization options so that you can 

view the response your way.  

 Note! You can view comparison responses for more than two entities. In this case, WhizAI shows 
only the data values; however, when you compare only two entities, along with the values, WhizAI also 
shows the absolute and percentage change in those values. Remember! When you compare two 
entities, you can select one of these entities as a base for carrying out the comparison.   

 

 Note! In a comparison response, WhizAI shows the percentage value along with the numbers.  Also, 
large numbers are shown as abbreviations, for example, 1,163,310 is displayed as 1.1 M or 447,334 is 
displayed as 447K.  

In response, WhizAI shows only the data for which you have authorization. 
 

You may see responses with a message that says: “You are not authorized to see data for <entity name>”.  

This is the case when you ask a query and you do not have the authorization to view the data in the 

response.  
 

For more information on Authorization, contact your system administrator. 

 Important! It is possible to configure WhizAI so that for some metric-dimension pairs, the metric and 
its corresponding values are not shown in the response. 

 

If you ask NLQs having multiple geographies that belong to the same hierarchy level, WhizAI adds the 

values and shows an aggregated response. For example, if you ask WhizAI: Show me the unit volume for 

Boston MA, Hartford CT, and Atlanta GA. 
 

In this case, WhizAI adds the unit volume for each of the geographies and displays the result. However, if 

you ask NLQs having multiple geographies that belong to an unrelated hierarchy level, WhizAI shall not 

give a response.   
 

In a comparison response having more than two entities, you can select any one entity as a ‘base’ entity and 

compare the remaining two with that base entity. 
 

For example, in a query such as: Compare Boston MA vs Chicago IL vs Philadelphia by months; any one of 

these three entities can be selected as a base entity. Assuming ‘Chicago IL’ is selected as the base entity, 

WhizAI displays a comparison response that contains details for Boston MA vs Chicago IL and Philadelphia 

vs Chicago IL. 

 Tip! WhizAI displays a comparison response for related as well as unrelated hierarchies. Thus, you 
can ask a query such as: Compare Boston MA vs New England vs Northeast by months. 
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For all tabular responses (except responses that show variance) WhizAI shows a ‘Total’ and ‘Sub-Total’ row 
and column, as applicable. Having these rows in the response adds to the insights you can derive out of the 
data shown in the response. 
 

For example: You can see such ‘Total’ or ‘Sub-Total’ row for queries such as: 
● By Regions By Brands 

● Brands by regions by districts 

● Units by brands 

● Units by months (or any other time scale) 

Following are the examples of different response types in WhizAI: 

Response – Chart 
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Response - Message 

 

 

Response – List View 

WhizAI supports “View as List” visualization option for single-metric, multi-metric, and variance response to 

display data in a single-row format, accessible across both Explorer and Pinboard.  

Example 1, TRx 

 
 

Switch to List view to view data in a single-row format as follows. 
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Example 2, TRx, NRx, NBRx 

 
 

Example 3, PoP TRx by 3 months 
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Response – Table 
 

 
 

In a tabular response, WhizAI shows you a list of metrics and attributes along with the generic data from the 

response.  

From this list, you can select an attribute and WhizAI adds the attribute’s data to the table.  
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 Note! Currently, you can select only those attributes that are directly related to the dimension, for 
example: Account and Account Type. 

Response – Question/ Answer 

WhizAI, being AI-enabled, understands the intent of a question. For certain questions, it provides 

descriptive information as an answer instead of analyzing the data from the database. 

Sometimes, your intent to ask the question is to know the definition, and meaning of a term, or even the full 

form of an acronym. In such a case, WhizAI understands these questions and provides the appropriate 

information in a formatted manner. 

Response – Map 

In a map response, you can click the ‘+’ button to zoom in on the response zoom in and view all the details. 

To get back to the original state, click ‘-’ so the system zooms out. In 'Maps' type visualization, you can view 

different geographical groups in different colors. Thus, you can easily segregate and identify regions based 

on the entity values of dimensions.  For example1, if you ask a query “Show me sales by cluster by countries 

on a map. In this case, WhizAI shows the data by clusters, assigns a unique color to every cluster, and shows 

it on a map. 

For example 2, if you ask, “Trx by Countries”, it will highlight the countries configured for your data model. 
 

 

Response – State level Map Visualization for USA and Canada 

In the 'Maps' type visualization, you can view different geographical groups in different colours. You can do 

state-level data analysis for countries USA and Canada by using Map Visualization. 
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Thus, you can easily segregate and identify regions based on the entity values of dimensions. 

 

For example1, if you ask a query: Show me Trx by states for USA 

In this response, WhizAI displays regions of the USA, grouping the data by clusters and assigning a unique 

colour to each cluster. 

 
 

For example2, if you ask a query: Show me Trx by states for Canada 

In this response, WhizAI displays regions of Canada, grouping the data by clusters and assigning a unique 

colour to each cluster. 
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Response - Bubble Map Chart for USA maps 

Bubble Map chart allows you to visualize geographically based data more effectively, thereby allowing you 
to analyze data from different locations. The bubble map chart utilizes bubbles to represent the data points 
and displays them in varying sizes based on the magnitude of the information. The bubble map chart acts 
as a powerful and interactive tool for analyzing and understanding data from different locations. 
 

The following are the key features that enhance its analytical capabilities. 

● Zoom in and out of the map for detailed analysis. 
● tooltip that provides detailed information about the data points. 

 

 Note! This is a configurable feature. For more information refer to the section Configuring Bubble 
Map Chart in the configuration guide. 

 

Example query 1: When you ask the query “Show me top 10 states by TRx for USA", you will get the 
following response. 
 

 
 

 

Example Query 2: If you ask, ‘show me Top 10 customers by cities by trx’, you will get the following 
response. 
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Response – Bubble and scatter chart 

A bubble and scatter chart is a type of chart that shows data points as bubbles. Each bubble represents a 
combination of three values: one metric value for the X-axis, another metric value for the Y-axis, and a third 
metric value represented by the size of the bubble. The bubble charts help us understand the relationship 
between these three variables. WhizAI assigns different colors to bubbles of different dimensions. Thus, it 
helps you to distinctly identify the different data points and you also get more context from the data in the 
visualization. 
 
Moreover, the bubble and scatter chart show horizontal and vertical grid lines, creating a clear quadrant 
layout. The negative bubbles are displayed with a red border, making it easier to identify and interpret data 
values and ranges at a glance.  If the chart axis begins with a non-zero number, then the 0 value is  clearly 
indicated with horizontal -vertical plot lines. This ensures intuitiveness and better clarity in the data 
displayed on the chart. 
 

 Note! The X-axis and Y-axis in a Bubble map chart are determined based on the order of the metric 
specified in the natural language query (NLQ) query. Metric 1: X-axis; Metric 2: Y-axis. 

 

Example Query: ‘Show me Nrx, Trx, NBRx, by region, by product’. 
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The bubble and scatter chart highlights the zero value with a dark gray grid line, creating a clear quadrant 
layout. 
As you can see, this bubble map chart represents prescription-related metrics for different regions and 
products. From this Bubble map chart, you can visualize: 

● X-axis: TRx (metric 1) 
● Y-axis: NRx (metric 2) 
● Bubble size: NBRx(metric) 
● Bubble: region (dimension) 
● Legend color: Product region (dimension) 

 

Thus, you can visualize new prescriptions (NRx), the number of total prescriptions (TRx), and the number of 
non-refillable prescriptions (NBRx) for each region and product. 
 

Each region is represented by a bubble, and the size of the bubble corresponds to the values of the 
selected metric (NBRx). The larger the bubble, the higher the value of the metric for that specific region and 
product. 
The products are represented by the legend color. 
 
 

Example Query 2: ‘Show TRx, NRx, NBRx by region’. 
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● X-axis: TRx 
● Y-axis: NRx 
● Bubble size: NBRx 
● Bubble /legend color: Region 

 
Example 3, Trx Growth NRx Growth NBRx Growth By Regions. 
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The bubble and scatter chart highlights the zero value with a dark gray grid line, creating a clear quadrant 
layout. 
The negative bubbles are displayed with a red border, making it easier to identify and interpret data values 
and ranges at a glance.  

 
 

Features of Bubble Chart 
● View distinct plots over the axis: This will enable you to see separate bubbles for different 

combinations of calls and referrals. It helps you understand how many physicians received at least a 
certain number of calls before making referrals. 

 

● Clicking any bubble shows a tooltip: When you click on a bubble, a tooltip appears. The tooltip 
provides information about the correlation between the size of the bubble and the values on the X 
and Y axes. For example, the tooltip could show that the largest brown bubble represents 2874 
physicians who received no referrals and made only one call. 

 

 Note!  When you hover over any data points, the bubble is highlighted. 

 

 Note!  This is a configurable feature. For more information refer to the section Configuring Bubble 
Map Chart in the configuration guide. 

 

Example query: When you ask the query “Show me top 10 cities by TRx for USA", you get the following 
response: 
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Response - Plotting customers or Health care professionals on map 

visualization 

 

WhizAI now supports Maps visualization that allows you to plot customers or HCPs in clusters. This provides 
a birds eye view of the count of customers and their location for analysis. 
 

 Important! As an administrator you can invoke map visualization by adding the intent Map view in 
the intentObject.csv file with code as "mapview" and level "object", and Latitude and Longitude under 
Dimension Attribute in Data Model configurations.  

 

 Important! From v74 onwards, the Map configuration settings has been updated to invoke map 
view visualization.  

 

If you click on the cluster counter (yellow color), the map is zoomed in to that area and all the 
customers/HCPs clusters in that specific area are displayed with individual counts (green color). If you zoom 
in till the last count, then the lat and long (blue markers) of the customers/HCPs are displayed. If you hover 
on the location, a tooltip is displayed which includes the customer name/HCP, metric, and other dimension 
details mentioned in the NLQ. 
For example, “customer name by TRx” 
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Response – Timeline 

When certain important events happen in a patient cycle or a sales cycle, you can view these events in a 

timeline chart. Along with the event, you can also view the respective periods when they have occurred. 

Every data point in this chart is displayed as a separate event along a horizontal timeline. Each data point 

has some descriptive text associated with it that gives information about the event. For example, this type of 

chart can be useful when you must view a patient’s journey. You can see the status with the date (Date of 

Admission, Surgery, Discharge, etc.). All the event dates are shown on a timeline chart. 
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 Remember! This visualization will not show a result when one event has happened on multiple 
dates.  

 

Note the following points: 

● WhizAI analyzes and displays the best visualization that is suitable for a response, however, if you 
mention 'timeline' in your query, by default, WhizAI displays the Timeline chart visualization. 

 

● For the Timeline chart to properly work, you need the following types of relationships between 
events and dates in the NLQ: Many to One or One to One. 

 

WhizAI shows a timeline visualization on both pinboards and responses for multidimensional queries. 

For example, when you ask ‘Show me region by response dates’ then in the response you can see the 

option for timeline visuals as shown in the following figure: 
 

 

Response – Area/ Percentage Area Chart  

Now, if you ask a query that includes 'Trend' such as " Show me Regions Trend" or "Show me the Products 

Trend", WhizAI provides the following additional visualization option:  

Area/ Percentage Area Chart as shown in the figure below: 
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Response – Hierarchical Charts 

You can view data in ‘Organization Chart’ format as shown in the following figure: 
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Charts help better analyze hierarchical data. A few points to note when using this visualization format for 

analysis: 

● Hierarchical charts are rendered when you ask (only) one dimension, and that dimension belongs to 

the same category (Geographical or Non-Geographical). For example, WhizAI will show a response 

for the following NLQ: Show me brand groups by brands in an organization chart. However, a 

response will not be shown for the following NLQ: Show me hierarchy chart for regions by districts 

by brands. Although it is required to include only one dimension, you can include more than one 

metric in the NLQs.  
 

● You can click every parent node to collapse the child nodes to get a compressed view. Also, you 

can view the charts in horizontal or vertical display, as shown in the above figure. If required, you 

can choose which hierarchy levels you want to see in the response. For example, a hierarchy chart 

for North-East displays Regions > Districts > Territories. In case, you want to view only Regions > 

Territories, WhizAI allows you to make such a selection in the response.  
 

● Every hierarchy level and its nodes are indicated by a particular node color. The colors of parents 

and children’s nodes are different.  
 

● When you change the card filter or pinboard filter, the details in the chart are updated. 
 

● WhizAI displays metric data upfront for a single metric hierarchy chart in compact mode. 
 

Viewing filtered Hierarchical Data  

When viewing data in hierarchical charts, if you apply a filter to a pinboard or a card, the hierarchy chart 

retrieves and displays the filtered data node and its child node. Also, if multiple entities are selected, the 

same are retrieved and displayed.  
 

For example, if the card shows data for the query By regions by districts and then you apply the filter - 

Region (Northeast); in this case, the hierarchical chart shows only the Northeast node and its corresponding 

districts. 
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Response - Sankey Chart 

Sankey charts are a type of visualization used to depict the flow of data between different levels. These 

charts represent the hierarchies and their levels. For example, if you ask ‘Trx by Regions by Districts’ then 

you get the response as shown in the following figure: 

 Note! The question mentioned above is a sample question. 

 
 

Response - Bump Charts 

WhizAI offers another visualization option - Bump charts. A Bump Chart is a simpler form of a line chart that 

can be used to view changes in ranks over time. With this chart, you can easily compare the position or 

performance of multiple observations. It can be used to view how a particular region has performed on a 

defined sales metric over a period of time. For example, if you ask the query ‘NRx by Region by months’, 

then you will get the response as shown in the following figure. 
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Response - Viewing the default sorting order 

For table responses, either on Explorer or Pinboards, by default, you can see a small arrow icon () beside 

the column name. This arrow indicates that when the response is generated, the data in that column is 

sorted, by default. 

Also, this icon indicates the sorting order, that is, if the data is sorted in ascending or descending order. This 

allows you to intuitively analyze the data findings. 

In the above image, by default, the data in Abs Chng column is sorted in descending order. To change it 
into ascending order, click the arrow. 

Following are the default sorting conditions for different types of responses: 

● Table responses: The default sorting order is ‘Descending’. By default, the data in the first metric 
column is sorted in that order. 

For example, Top districts by TRx 
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● Responses having multiple dimensions: The default sorting order is ‘Ascending.’ By default, the 
data in the first metadata column is alphabetically sorted in that order. 

For example TRx by Customer by product 

● Metric - TRx 
● Dimension - Customer, product 
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● Responses with Nested data and period-over-period comparison: Default sorting order is 
‘Ascending’ and by default, the first metadata column is alphabetically sorted in that order. The 
nested columns represent a multi-dimensional response. 

For example, Trx by region by product 

● Metric - TRx 
● Dimension - product, region 

For example, product by region by district 

● Metric - TRx 
● Dimension - Product, Regions, Districts 
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● Absolute change column for all PoP/Variance and Comparison responses - Default sorting is 
placed on the abs chg column. 

For example: Arobi vs ofasan by district. 

● Metric - Trx 
● Dimension - Arobi, Ofasan, Districts 
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Response - Intuitive Time period labels for Period over Period (Variance) 

response  

Time periods displayed in the column headers of a Period over Period (PoP) response are intuitive and thus can be easily 
understood. Instead of date ranges, WhizAI displays explicit labels that describe the time period represented. For 
example: Show me QTD TRx POP by brands. 
 

 
 

Response - Evolution Index Calculation for Time Period Filters  

WhizAI supports accurate Evolution Index calculations for all TD buckets i.e. QTD, MTD, HTD, and YTD time 

period filters on weekly trend charts. This accurate Evolution Index allows users to compare week-over-

week periods within a selected time period to the exact same weeks in the corresponding previous period, 

ensuring precise and meaningful insights. For example, the system compares the last two weeks in the 

current quarter to the last two weeks in the previous quarter. 

Example, qtd trx evolution index by weeks by regions for product Arobi 
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Response - Bridge chart 

WhizAI supports Bridge chart for variance/ Period over period response for comparing continuous periods. 
The chart  represents the absolute change in data from the previous period to the current period. This chart 
either displays sequential or categorical data. It uses a series of floating bars displayed in green and red 
indicating increase or decrease. It illustrates how initial figures were influenced by events, resulting in the 
final figures. The start and end bars depicted as full bars on the axis represent the totals. 
  

 Note! The NLQ should be a single dimension, single metric POP. 

 
Example 1, Last 3 months PoP by regions for Trx 
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The chart represents how the absolute change in TRx in the regions for a period of 3 months influences the 
total TRx of the current period.The start and the end bar represent the totals of TRx of last three months and 
current three months respectively. The floating bar displays the gains or losses represented by absolute 
change. 
  
Example 2, Region by months PoP for Trx for 2021 

 
 
It represents absolute change in TRx for regions with time granularity (month) in year 2021. 
 
Example 3, show declining customers 
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It represents the decline in absolute change in TRx for customers (indicated in red bars) between the period 
YTD(Year Till date and prior year till date). 
 

 Note! If you apply a follow-up on the bridge chart, the variance table is displayed with the follow-up 
values populated. 

 

 Note! Enabling spotlighting highlights the filtered value bars in the charts. 

Response - Smart Totals 

WhizAI gives the ability to view totals for computed metrics for all the applicable responses. The totals  

are calculated based on computational calculations. For example, if you ask WhizAI ‘Show me region by 

brand for TRx marketshare’ then in the response table, you will see the total percentage of each brand 

against all the regions. 
 



Understanding WhizAI User Interface 

 

 

48 of 315 

 

Response – Semester-level Volume and Growth 

WhizAI allows you to call "semester-level" volume and growth in the same way that you can pull "YTD", 

"QTD" and "latest month" volume and growth.  
 

For example, you can ask: "What was S2 2020 YOY" which means the last 6 months of 2020 percentage 

growth versus the last 6 months of 2019.  

Also, you can ask: "What is the semester-level trend since 2015 for Brand A" which would give semester-

level volume for Brand A in a trend line since 2015. 
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Response - Bar charts 

For bar charts, data is displayed in horizontal bars with different colors (Please refer to the image). For this 

chart, categories of data are displayed on the vertical axis and the data values are displayed on the 

horizontal axis. 

This way, this horizontal bar graph can be used to visualize comparisons between various metrics and 

thereby also analyze the data performance. For example, if you ask the query ‘TRx, NRx, NBRx by regions’ 

you will get the response as shown in the following figure. 
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Response – Column Graph 

In this visualization option, data is displayed in vertical bars that go across a horizontal axis. These charts can 

be used to view data comparisons. For example, you can compare data across brands for a particular metric 

or you can compare data for brands in different regions, etc.  

Example queries:  

● Show me data by brands,  
● Show me data by brands by regions  

 

Response - Column Group chart: Sort data on the Y-axis in Descending order 

You can sort the bars in a Column Group chart response in descending order. For example: 

NLQ: Show me the TRx by Customer Tier and Regions 

Response: 
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This Column Group chart contains a drop-down list at the top-right side that contains the following values: 
● Default 
● Data 
● Name (A-Z) 
● Name (Z-A) 

 

Earlier, when you clicked Data from this list, there was no change on the bars of the Column Group chart. 
However, now, when you click Data from the drop-down list, the bars in the groups of columns get sorted in 
descending order as shown in the figure below: 
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 Note!  The behavior of all the other options of the column group chart (i.e. Default, A-Z, Z-A) remains 
unchanged. Also, for all the other charts, the behavior of all the options in the drop-down list remains the 
same. 

 

 Note! Zooming is disabled for column group/Stack chart only for the data sorted chart. 
For default sorting or sorting by name, zooming is enabled. 

Response - Grouping and positioning of metric-axis scales in bar and column 

charts 

You can group the Y-axis and X-axis metric scales together in column and bar chart respectively if their unit 

of measurement and metric category are identical. This feature ensures accurate data interpretation, when 

multiple scales have different units.  

In addition, you have the flexibility to adjust the axis position for vertical charts, shifting it from left to right or 

vice versa, and for horizontal charts, moving it from top to bottom or vice versa. 

Follow the steps given below to group-ungroup axes having comparable metrics on bar or column charts. 
Consider the following example, Top regions by TRx, NRx, NBRX.  
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1. Click on the scale to which you want to group with the other scales.  
a. Click + on Group option and select the metric axis you wish to group and click Apply.  
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The scales are grouped together and are adjusted as per the Highchart standards. 
 

   Note! If you ungroup the scales, ungrouped scales are displayed besides each 
other.  

 
b. Click on the axis you wish to adjust the axis position and switch the toggle position either to 

left or right. Click Apply.  
 

 
 
OR 

Example2, Top regions by TRx, NRx 
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 Note! Contact the system admin to enable the global configuration ”Merge axes for metrics with 
same units” to display the identical metrics on the same axis. 

 

 Tip! To separate the axes, go to the drop-down arrow and click the Unmerge toggle. 

Response - Table total support for Time Granular Data Views 

The total is displayed for metric columns in responses involving only time granularity, without additional 

dimensions.  

Totals are displayed for various time granularities, such as weekly, monthly, quarterly, semesterly, and 

yearly, and are included in export formats (XLS, PDF, PPT). 

 

Example1,Arobi vs Plabenil vs Ofasan by months  

 
 

Example 2, Trx by months PoP 
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Response - Displaying Full Date Range 

WhizAI supports the display of full date ranges on the X-axis for tables and charts using granularity. Users 

can view date ranges ( "Jan 1 to Jan 11, 2024 or 2022 - 01 - 07 to 2022 -01 - 14") instead of only single 

dates, enhancing data interpretation and analysis. This feature is configurable at the model level and 

extends to other time granularities such as monthly and yearly. Date ranges are preserved in all exports 

(XLS, PDF, PPT) and are available via tooltips when space is limited. The date format adapts to language 

settings and handles year transitions appropriately. 

 

Example, WoW for last QTD by Trx, Nrx 
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Example 2, TRx and NRx weekly 

 
 

 

 

Response - Additional Dimension Selection Based on Metrics 

 Note! This is a configurable feature. For more information refer to the section Configuring Top N 
Additional Metadata in WhizAI Configuration Guide. 

 

When you want to apply additional dimensions to list responses (such as “top 5 customers”), the table 
configurability (Columns drop-down list) dialogue shows both the common and uncommon dimensions for 
a particular set of metrics that are selected from this dialog. Consider an example, 
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The following metric dimension association exists in the above example: 
 

Metric Dimensions associated with the metric Common Dimensions Uncommon Dimensions 

NRx Region and District 

Region District and Customer Tier 
TRx Region and Customer Tier 
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To add additional dimension: 
1. Go to Data Controls >Columns > select checkbox for Metric. 
2. Select the metric TRx, NRx 
3. Select the Dimension checkbox and click Apply. 

 

 
 

Earlier, after selecting NRx and TRx, you could only see the dimension Region (as it was the common 
dimension associated with both the selected metrics). Now, you can see all the dimensions, that is, Region, 
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District, and Customer Tier (even the uncommon dimensions are selected). Thus, now, there is no need to 
manually select the uncommon dimensions when analyzing different metrics. The uncommon additional 
dimensions are selected automatically based on your metric selection. 
 

 IMPORTANT! If there are multiple metrics on response and you add an additional dimension from 
the table configurability (Columns dropdown). If this additional dimension is associated with only one 
metric, then for all the other non-associated metrics, the system duplicates the values in multiple rows. 
This ensures correct totals for the metric values. 

 
Example query: ‘Show me top customers by Call Volume, NBRx, Call Goal’. 
 

 
 
 

In the above example, you can see that customer Michael Johnson has distinct NBRx values for every 
territory (one-to-many relationship). However, the values for metrics Call Goal and Call Volume are 
duplicated for the Customer Michael Johnson, as both these metrics are not associated with the dimension 
Territory (the additional dimension Territory is not configured for the metrics Call Goal and Call Volume). 
 

 Note! The duplicate values of metrics Call Goal and Call Volume do not affect the value in the Total 
row. 
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Response Options - Hiding Columns in a Tabular Response 

For a table response, WhizAI allows you to hide columns as shown in the following figure: 
 

 
 

Hiding the irrelevant data helps make the tabular response easy to read and less cluttered. 

Response Options - Searching for Data within a Response 

You can search for data in tabular responses. When you open a tabular response, you can see a search 

field. Click Search and enter the details you want to find. As you begin to type details in the search box, 

WhizAI searches and displays the record.  
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Response Options – Enhancing table responses 

Now, WhizAI facilitates your configuration in a tabular response, as required, you can use the following 

options while configuring the tabular response. 

Using the Scroll bar to navigate to the last row 

Now, for a tabular response that spans multiple pages, you can scroll through the response to the last row 

irrespective of the number of records in the response.  
 

 
 

Earlier, the response showed the pagination option, only, to browse through it.  

Searching data in a dimensional column 

WhizAI allows you to search data in each dimensional column in a tabular response. 

You can go to a particular column, define certain filter conditions, and search for the data that you are looking 

for. Follow these steps to search:  

1. From the response column, click the hamburger menu. WhizAI opens a dialog box that has two tabs. The 

first tab (default) contains options to pin a column, etc. (refer to the figure below). The second tab allows 

you to define filter conditions to search for details in the response. 
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2. Click the  icon to go to the filter tab. 
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3. Select the filter condition, as required. 
 

4. In the Filter text box, enter the data value and click Apply.  

 
 

 
5. WhizAI searches and displays the records according to the defined filter conditions. Also, you can click 

Reset to clear the searched record. 

 

Pinning Columns: 

You can pin dimension columns of tabular responses either to the left or right, as shown below: 
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You can use the Pin Column option that allows you to lock the columns so that when you scroll either to the 

left or right, the pinned column/s remains on the screen. 

Copy, and Copy with Headers Details 

You can copy and paste the data from a tabular response as shown in the following figure: 
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If you right-click a particular row, you can see options as shown in the above figure: 
 

● Copy:  Copies the data from a tabular response. You can then paste it, as required. 

● Copy with Headers:  Copies the data with column headers from a tabular response. 

Auto Sizing Columns: 

You can auto-size the columns in a tabular response without having to manually adjust the width. Let’s say 
the TRX column was wider as shown in the following figure:  
 

 

After you click the Autosize Column option, WhizAI automatically adjusts its width. 

Responses - Supporting XLSX export for all the responses 

You can download an XLSX file for all different types of responses, irrespective of the number of records in 

them. The downloaded XLSX file captures the entire data that is displayed on the response table.  
 

For example, if you ask ‘Show me top customers’ and from the table click the Download as XLSX option as 

shown in the following figure. 
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The downloaded XLSX file displays the entire data from the response table. On cards, when you make 

some changes on the table and then download the XLSX file, the downloaded file retains the changes.  
 

For example, if you ask ‘Show me TRx by region by product’ then you receive the response as shown in the 

following figure. 
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Now, when you reorder the column Arobi and download the XLSX file, the downloaded XLSX file retains 

the reordering of columns. 
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 Note: Now, for a tabular response that spans multiple pages, you can download the XLSX and CSV 
files irrespective of the number of records in the response. 

 

When you export the XLSX or CSV file, you can continue to use WhizAI until the file gets downloaded. For 

example, when you ask, ‘Show me top regions by TRx’, WhizAI shows the following response. 
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When you click the hamburger menu    and then click either Download as CSV or Download as XLSX 

options, the following dialog displays. 
 

 
 

You can click OK and continue to use the WhizAI application. After the file is ready to download you receive 

a notification with the download link as shown in the following figure. 
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Response Options: Enhanced tables for Period over Period (POP) and 

Comparison responses 

You can now hide or show the available data in the tables for the POP or Comparison responses. For 

example, for a POP response if you ask a query, ‘Show me Brands POP for TRx, NRx’ then in the response, 

you can see a Data Controls tab. Under the Columns option, you can select or clear the checkbox to hide 

or show the data available on the response. 
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Similarly, for a comparison response, when you ask a query, ‘Compare Boston MA vs Chicago IL vs 

Philadelphia by months’ then in the response, you can see a Data Controls tab. Under the Columns 

dropdown this dropdown, you can select or clear the checkbox to hide or show the data available on the 

response. 
 

 
 

The following enhanced table features are also available for the PoP and Comparison responses: 

● Scroll bar to navigate to the last row 
● Ability to search data in a dimensional column 
● Pin columns to the Left/Right/No pin  
● Option to simply copy and paste the data or copy with headers details 
● Auto sizing columns 
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Response - WhizAI response for trend queries that include growth computation 

For trend queries that include growth computation, WhizAI renders a trend response where the trend line is 
plotted over multiple data points. Plotted data points (growth values) are calculated by comparing the 
metric values with previous periods in the given time period. 
 

Consider the following scenarios: If you ask for weekly/monthly/quarterly/yearly growth trend for any time 
period (for example: last month, last 2 months, last quarter, YTD, QTD, MTD); then in the response, a trend 
line is shown for growth for the granularity in the specified time period. For more information, refer to the 
following example. 
For example, if you ask ‘TRx growth by months this year’ here the granularity for the trend is ‘months’ and 

time period is ‘this year’. In this case, data points (growth values) are calculated from the period over period 

(pop) comparison and not year over year (yoy) comparison, meaning the growth trend is shown by 

comparing month 1 with month 2, month 2 with month 3, month 3 with month 4 and so on. 

 

 

Response - Persisting user actions on an explorer card 

WhizAI automatically saves changes made in explorer cards (tables/charts) and persists them when pinned 

to the pinboards.  

Following user actions are persisted  

• hiding/showing columns through table configurability 

• resizing and reordering columns 

• pinning cards 

• grouping and ungrouping axes on charts 

• changing position of axis on charts 

• sorting in charts  

• expanding/collapsing hierarchy nodes 

This maintains your customizations across explorer and pinboards. 
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Response - Applying to Board from cards 

On cards when you click Apply to Board, only those pinboards are displayed that are relevant to the 

record. For example, when you ask a response NLQ ‘Show me top customers’ and hover the cursor over this 

icon  against Michael Johnson and click the Apply to Board button. 
 

 
 

The list of only those pinboards where the customer Michael Johnson is available is displayed as shown in 

the following figure. 
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 Note! In the previous version, when you clicked Apply to Board, the entire list of pinboards was 
displayed. The boards that were not associated with the record were displayed in gray color and when 
you hovered the cursor over those pinboards, a tooltip was displayed ‘This board does not have any 
matching filters. 

Response - Enumerated data 

WhizAI supports NLQs that render enumerated responses. An enumerated response contains a list of all the 

data objects (dimensions) or shows the total number of objects for a dimension included in the NLQ. Data 

objects can be employees, resources, patients, etc. 

You can configure the source data to add flag variables such as Yes (true) / No (false). These variables are 

set for different dimensions in the data. Flag variable signals WhizAI that a certain condition has been met. 

This signal acts as a Boolean variable indicating a condition to be either true (yes) or false (no). WhizAI 

associates flag variables with the respective dimension included in the query and provides enumerated 

responses. 

For example: In the following data, two employees are COVID-infected, and the variable set for them is 

'true' (Y). One employee is not infected by COVID, and the variable set for this employee is 'false' (N). 
 

Data assets 
Is COVID 

affected 
Flag variable 
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Employee 1 Yes Y 

Employee 2 Yes Y 

Employee 3 No N 

 

Example query 1: How many employees are COVID affected? 

 
 

Example query 2: How many employees are not COVID affected? 

 

NLQs - Dynamic Sizing of Auto-Suggestion box 

When you begin to type a question in the Conversation box, the auto-suggestion box prompts you with 
synonyms, suggestions, or spell checks. 
 

Now, this auto-suggestion box is dynamic, so that you can see the longer entity names clearly in a single 
row. The box is not wrapped up below, thus, more entities are seen in the search result with the box size 
being vertically reduced. 
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Response - Viewing data or images using external links on cards 

On pinboards and responses, certain cards contain clickable links that are associated with corresponding 

dimension values displayed in the cards. 
 

For example, if you ask a query ‘Region by TRx by call goal’ then WhizAI shows the following response: 
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 For any dimension value, when you hover the cursor over this icon  WhizAI shows the following options: 

• View link: redirects to an external link that shows the data. 
• View image: redirects to an external link that shows the images.  

 

When you click the link, you get redirected to a new tab where you can view data or images associated with 
those dimension values. This provides you with additional capabilities to perform a better analysis of the 
data displayed in the response. 

Response - Changing Card Formats 

You can change the format in which the details are displayed on a card. Broadly, you can change the format 

from ‘table’ to ‘chart’ and vice-versa. Open the card from the pinboard and below the card, you can see a 

list of all the formats available for that response: 

 
For example: In the following figure, the Line response is changed to Column response. 
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Response - Downloading Data from Cards 

Open the card from which you have to download data, click  and then click Download CSV, Download 

XLSX, or Download Image. WhizAI downloads the card data in CSV or PNG formats. 
 

 

‘Partial’ text displayed in the downloaded file (XLSX) 

When you download (XLSX format) a response that contains multiple time periods, you see the ‘partial’ text 

against the metric values for months with partial historical data. 
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Example Query: “Arobi vs ofasan by months in 2021, 2022” 
 

 
 

Go to the hamburger icon  at the top right corner of the options and click Download as XLSX. 
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In the downloaded XLSX file, the TRx values for Ofasan and Arobi in May 2022 are accompanied by the 
string "partial." 

 Important! Please note that MS Excel functions and operations, including calculations for totals, 
percentages, and other formulas, can be impacted by the presence of this text. Make sure you take 
appropriate notice of the "partial" text to avoid any unintended effects on calculations or data analysis. 

Response - Providing Feedback 

WhizAI provides a feedback system by which you can give your feedback and comments about using the 

WhizAI platform. While working with WhizAI, it might be possible that the platform does not understand the 

question, does not respond correctly, or displays incorrect data. In such cases, WhizAI would like to 

understand the issue so that the experience can be improved by making the necessary updates. 
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For each response, you can find the Was this helpful? link with yes and no options.  

After you select Yes, WhizAI mark that answer to the response. However, if you click no, WhizAI opens the 

feedback dialog box for you to submit the feedback. 
 

In the dialog box, select the correct type of your feedback and enter any additional comments, if any. Click 

Send Feedback to submit the feedback. 

The feedback is submitted to the WhizAI Administrator. Additionally, you can also view the feedback in the 

User Logs. 

Using Commands 

This chapter explains the default commands that WhizAI provides out of the box. 
 

Command  Response from WhizAI platform 

Hi WhizAI greets you and lets you know that it is ready to get started. Also, it gives 
you information about the currently available sources. 

Help WhizAI displays the initial help so that you can learn about asking questions to 
WhizAI. 

Context WhizAI displays the current context that WhizAI has established from the 
previous question asked. 

Reset WhizAI resets the context established from the previous question.  

After resetting the context, when you ask a question, WhizAI gives you the 
response without assuming any prior context.  

Also, this command can reset all or a specific dimension or metric.  

For example, reset territory or reset TRx Volume. 

Show dimensions WhizAI displays all dimensions currently available in the selected data model or 
a data source. 

Show metrics WhizAI displays all metrics currently available in the selected data model. 

Show CSV 

Show XLSX 

WhizAI displays a link to download the response in a CSV and XLSX file. 

 Note: This command only works when the response is in 
tabular format. Otherwise, you get the error message that the 
response is not in the correct format to download. 

Go to <data source> WhizAI switches the current data source to the specified data source name. 
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NLQs 

NLQs - Handling "Since-Time" Expressions in Queries 

WhizAI supports an expanded range of "since-time" expressions for queries. This feature improves the 

system's ability to understand and process various ways users express time-based queries. Based on user 

feedback, the system now recognizes a broader set of variations for the "since" operator. Now, you can use 

variations like starting, onwards, to date, to current, from-to date, till date and the system provides the 

correct response 

Some examples and variations of since expressions are as below. 

  

• Number of products for June to date 
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• All TRx 2022 to current 

 
• TRx trend since Mar 2022 
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NLQs - Using Cohort in NLQs 

WhizAI integrates NLQs with Cohorts, allowing you to apply cohorts within the explorer context. This 

functionality ensures responses match the predefined conditions set for the target dimension in the cohort.  

 

NLQs can identify and utilize cohort for analysis. This feature is available for owned and shared cohorts. 

Additionally, you can find the correct cohort name using the auto-suggestions that appear while typing. 

The responses generated will pre-dominantly depend on the types of cohorts (static or dynamic) used in 

the NLQs. 

 Note! Cohort functionality is supported only with API metrics that use scripts in new format 

For more information, let’s look at the examples below: 

Static cohorts 

Example1, You can query, “Show top 10 Customers for Chort1”, where the predefined condition for 

Cohort1 is customers belonging to 1960 Family Practice, 1960 Family Practice Harmony, 25 East Same Day 

Surgery Center, and 463 Beverly Hills Llc.  

 

Tip! In this case, the target dimension and the condition dimension are the same, so the generated list of 
responses will always remain static and will not change over time. 
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Example 2, you can query “TRx for cohort 1 by region” where the predefined condition for Cohort1 is 

customers belonging to 1960 Family Practice, 1960 Family Practice Harmony, 25 East Same Day Surgery 

Center, and 463 Beverly Hills Llc. 

Tip! In this case, the generated response gives an aggregated value of the cohort by default. 
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Dynamic Cohorts 

Example 1,  you can query, "Show top 10 customers for Cohort2”, where the predefined condition for 

Cohort2 is customers belonging to region Mid-Atlantic and gender female." 
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The cohort will filter the list of 10 customers by TRx (TRx set as default in context) for the set context period 

and the conditions set in the cohort. 

Tip! From the table configurability box, select the dimensions set in the conditions of the cohort. 



Understanding WhizAI User Interface 

 

 

90 of 315 

 
 

Example 2, “Regions by CohortArobi vs CohortPlabenil”, where the predefined condition for CohortArobi is 

customers having the product Arbobi and predefined condition for CohortPlabenil is customers having the 

product Plabenil. 
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The generated response lists regions for the target customers and displays the absolute value and % 

difference values for the product Arobi and Plabenil for those regions. 

 

Example 3, “weekly trend of Sales from Senior Customers vs Young Customers from last 3 months ”, where 

the predefined condition for Senior Customers is customers having age group 60 and above predefined 

condition for Young Customers is customers having age group 19-30, 31-40.  
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The generated response compares the TRx trends for cohort Senior Customers and Young Customers for 

last 3 months.  

 

 Note! Clicking on a cohort name automatically applies it in the user context, visible in a drop-down 
list of existing cohorts. 

Conditions for overriding/ persisting cohort in user context 

• NLQs containing a dimension name matching the cohort's target dimension display individual 

elements within the cohort. ? 

For example, Show me Cohort 1 by patients will give me all individual patients by the default Trx 

metric. 

• NLQs containing an entity value matching the cohort's target dimension replaces the cohort in the 

context with the new value. 

For example, Cohort has Customer dimension and when the NLQ contains By Customers, the 

system does not override the already applied cohort and gives results based on the cohort only. 

If the cohort includes the Customer dimension and the NLQ specifies "By Customers," the system 

maintains the previously applied cohort and provides results based on its conditions without 

overriding it. 

• NLQs containing a dimension name matching a cohort condition display data based on the cohort's 

conditions. 

• If a dimension value in the NLQ does not match the context filter value, the system throws a "no data 

found" error. 

• If a new cohort name is asked in the NLQ, then the system replaces the previous cohort in the 

context bar with the new cohort from NLQ. 

• If the NLQ contains a dimension/value that is neither the target dimension nor the condition, is 

treated as an additional filter. 

• For example, Show me Cohort1 by customer by region, where the predefined condition of Cohort1 

is customers having age group above 60. In this case, the dimension ‘region’ asked in the NLQ will 

be treated as an additional filter in the response. 
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NLQs - Improved error messages 

WhizAI displays improved error messages with suggestions for refining search parameters, selecting 

appropriate time periods, or modifying query formats, facilitating a smoother data search process.  

The error messages aid in simplifying the user query ambiguity and supports more efficient NLQ 

navigation. 

The following error messages are rephrased. 

• No data available for your current scope of the filters in the context. Try asking again with updated 
search criteria. 

 

 
 

• No data available for the requested time period. Please select a timeframe between period 1 and 
period 2 and try again. 
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• The current type of query isn't supported at the moment. We'll notify you as the system learns and is 
able to support such questions. 

 

 

NLQs - Support for multi-metric entity comparison 

WhizAI supports multi-metric entity comparison, that is, you can compare more than one metric for the 

entity or time comparison. For more information, refer to the following examples: 

● TRx, NRx for Trexine vs Plabenil 
● TRx, NRx for Trexine vs Plabenil by brands by regions 
● TRx, NRx for Trexine vs Plabenil by brands 

NLQs - Support for positive and negative expressions in queries 

WhizAI understands positive and negative expressions from your queries. 
 

Positive expression: A query with a positive expression usually conveys a favorable result. 

Example query: Show me regions with positive sales. 
 

Negative expression: A query with a negative expression usually conveys an unfavorable result. 

Example query: Show me regions with negative sales. 

NLQs - Support for interrogative questions 

 Note! You must configure the business action for linguistic intent support queries. For more 
information refer to the configuring business actions section in the NLP guide. 

 

WhizAI also supports interrogative questions, providing even more versatility. This improvement includes 

the addition of the following question types: 

● Where: Now you can ask data for specific geographic locations such as regions, districts, or territories 
(which can be customized according to your needs). For example, “Where was Trexine sold the most?” 

 

● When: This question type provides detailed information regarding the timing or dates of certain events 
or actions. For instance, it can reveal when a patient was admitted or when a customer clicked on emails. 
For example,” When was the patient admitted to the hospital?” 

 

Consider the following queries: 
 

Example query 1: When you ask show me Where was plabenil sold the most last year? WhizAI filters results 

based on Plabenil and automatically sorts them in descending order by default. 
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Example query 2: When you ask show me When customers clicked email? WhizAI filters results based on 

Emails-Clicked and automatically sorts them in descending order by default. 
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NLQs - Support for different variations of the same query 

WhizAI understands different variations of the same query. Different queries can have the same underlying 

meaning but can be structured and asked differently. 

For example, consider the following queries that convey the same intent but have different phrasing: 

● Show me comparison for Trexine and Plabenil 
● How is Plabenil doing against Trexine? 
● How are plabenil and Trexine performing against one another? 
● How are plabenil and Trexine doing against each other? 

WhizAI understands such questions that can be structured differently and renders the response 

accordingly. 

 Note! The above list of example queries is not a comprehensive list. The purpose of these examples 
is to show how the same question can be asked using a different variation and WhizAI still understands 
and supports the same. 

 

NLQs - Questions having multiple time periods with multiple metrics or entities 

You can include multiple time periods, metrics, and computations in your queries. For more information, 

refer to the following example queries with responses. 
 

Example query: Show me the YTD, HTD, QTD , current month, and current week for TRx, NRx 
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NLQs - Complex time expressions 

For example, if you ask WhizAI: “Show me sales for first 4 weeks of last quarter of last year”; in this question, 

you have included a combination of multiple time references (first 4 weeks, last quarter, last year) instead of 

asking the data for only specific time period or specific date range. In such cases, WhizAI comprehends 

such complex time period references and renders the response accordingly. Thus, along with specific time 

periods or intervals, you can use relative time references in your queries and WhizAI identifies them with 

ease, processes them, and renders the response accordingly. 
 

Refer to the following additional example queries with such time expressions. 

Arobi sales in Boston for last month of last year 

Show me sales by brands for first 8 weeks of second quarter in 2021. 
 

Example queries: 

Q1 vs Q2 by brands for last year - In this query ‘last year’ is associated with time periods Q1 & Q2. 

NLQs - Using MAT expression in queries. 

MAT stands for Moving Annual Total. It is the total value of a variable over the past twelve months, as the 

twelve-month period moves forward with each month, the value from the latest month is added and the 

sales value from the oldest month is removed from the calculation. This means MAT considers the most 

recent month as the endpoint. When you include MAT expression in the query, the response shows the 

sales value for the last twelve months with respect to the time period mentioned in the query. If you don't 

specify the time period, then by default, the last twelve months are considered. For more information, refer 

to the following examples. 
 

You can include the following types of expressions along with MAT in your questions: 

● reference time periods such as ‘last month’, ‘last quarter’, last year, etc. Example queries: MAT last 
month, MAT for Q3 last year, and so on. 

 

● monthly, quarterly, yearly trend - Example queries: Monthly MAT 2022, Monthly MAT for Q3 2022, 
Yearly MAT for the last 5 years, and so on. 

 

● period over period / year over year analysis - Examples queries: MAT Jan 2022 PoP, MAT Q3 PoP, 
MAT Jan 2022 YoY, MAT Q1 YoY and so on. 

NLQs - Support for CAGR (Compound Annual Growth Rate) computation 

WhizAI supports CAGR computation. CAGR stands for Compound Annual Growth Rate. It is a widely used 

measure to evaluate the growth rate of a business over a specific period of time. It considers the 

compounding effect and gives you a clear picture of the annualized growth rate. Refer to the following 

example queries on the use of CAGR computation. 
 

Example query: Show me CAGR for the last 5 months. 
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 Note! This is a configurable feature. For more information, please contact the WhizAI support team. 

NLQs - Using trimester and semester expressions in queries 

WhizAI supports Trimester over Trimester (ToT) and Semester over Semester (SoS) time expressions in 

NLQs. Semester and Trimester granularities are supported similarly to the other granularities such as 

weekly, monthly, quarterly, yearly, etc. You can include ‘by trimester’ or ‘by semester’ in NLQs to specify the 

time granularity in the response. Trimester expression divides a period of twelve months into three periods 

of four months. If you include a ToT expression in a query, WhizAI compares the given metric for the current 

four-month period with the previous four-month period and gives you the absolute and percent change in 

the metric value. 
 

Semester expression divides a period of twelve months into two periods of six months. If you include SoS 

expression in a query, WhizAI compares the given metric for the current six-month period with the previous 

six-month period and gives you the absolute and percent change in the metric value. 
 

For more information on the use of these expressions, refer to the following table. 
 

Example NLQs WhizAI response 

TRx in 2021 by trimester TRx trend in 2021 by trimester. / TRx in each trimester in 2021 

T1 2021 by months for 

TRx 

TRx trend in the first trimester in 2021 by months. 
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SoS Compares TRx for the current six-month period with the previous six-month period 

NRx in 2021 SoS Compares NRx for 2021 by semesters (H2 vs H1) 

ToT Compares the given metric for the current four-month period with the previous 

four-month period 

ToT 2021 Compares the given metric for 2021 by trimesters T2 vs T1 and T3 vs T2 

TRx STD PoP Compares TRx value for the period of current semester till date with the same 

period of previous semester 

TRx TTD PoP Compares TRx value for the current trimester till date with the same period of 

previous trimester 

 

Example NLQs with the responses 
Second half of last year 
 

 
 

Show me monthly trend for 2nd half of last year 
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Show me NBRx trend for first half of 2021 
 

 

NLQs - Using 'Day' expression in queries 

Similar to time granularities such as 'year', 'quarter', ‘month’, ‘week’ etc., WhizAI now also supports ‘Day’ 
time granularity. You can now use the following time expressions in your queries. 
 

● Days 
● Daily 
● Day over day (dod) 
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● last <N> days 
● previous <N> days. 

 

Refer to the following example queries: 
 

Query type Example queries 

Last/Previous/Current N 

days 

Show me sales for the last 10 days 

Note! Last/Previous/Current N days will include ref date set in the context on the 

Explorer. 

Trend - ‘Daily’ Daily sales trend for Jan 2021 

Show me daily sales for Q1 2022 

Day over Day (DoD) Show me dod query count 

Show me dod NRx for last 10 days 

 Note! Responses for these NLQs are rendered with reference to the date set in the context on the 
explorer. 

 

 Note! To use the above-mentioned expressions in your queries, you must refresh the data daily. 

 

Example NLQs with the responses: 
 

Example 1: Show me sales for last 50 days 
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NLQs - Co-referencing: Asking follow up queries with reference to the previous 

query 

You can ask follow-up queries by co-referencing the entities in the previous query. For example: If you have 
asked ‘Show me top brands of last year’, you can ask a follow-up query as ‘How are they trending this year?’ 
WhizAI understands this follow-up query and co-refers the word ‘they’ with the ‘brands’ asked in the 
previous query. You can use the following type of pronouns for co-referencing. 
 

● they 
● their 
● this 
● them 
● these 
● those 
● it etc. 

 
Example: 
Initial query: Show me top brands of last year 
 

 
 

Follow-up query: How are they trending this year? 
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NLQs - Support for contextual conversations and co-referencing 

We have improved our co-referencing support for list responses, that is, a new response is generated 

based on the previous query using certain keywords namely their, they, those, them, etc. 

Important! Co-referencing works on NLQs that provide a ‘list’ as an output. 
 

Following is the list of supported list responses:  

● Top 5 regions <TopN/ BottomN> 

● Top 5 growing regions <TopN Time Comparison/ BottomN Time Comparison> 

● Top 5 regions by brands <Multi-dimensional> 

● Top 5 regions by trend <Top N trend/ Bottom N trend> 
 

Following are some examples of co-referencing contextual conversations. 

● Top 5 regions by TRx 
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Follow up query: How are they performing? (PoP for same top 5 regions) 
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In the example mentioned above the list response of regions is contextualized to know how they are 
performing. 

 

● Top 2 brands by NRx 

 

 
 
Follow up query: Show me their TRx. (Note that the NRx metric was included in the original NLQ, as a 
response for this question, WhizAI has switched the metric and the TRx for top 2 brands is shown in 
the response) 
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In the above example, as you can see, the contextualized conversation supports the metric switch. 
This allows you to instantaneously compare the values between two metrics. 
 

● Show me the top regions by Arobi 

 

 
 

If you see, the context is set to Arobi. Now, you can ask : How did they trend 
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Thus, in the above-mentioned example, the context set earlier is persevered. 
 

Show me their performance by trexine 
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In this example, the context set to Arobi is replaced with Trexine. 

 

● Show me top regions by TRx. 
 

 
 

Show me their NRx 
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Show me their performance 
 

 
 

In this example, the new response is sorted on the latest NLQ and not the 1st one. 
 

 Important! You cannot pin them for your reference, as the pin icon is not available. Also, the entire 
context is lost if you reset the content, or a fresh question is asked which is out of context. The titles of 
these responses are always carried forward with the latest intent and metric. 

NLQs - Using ‘My’ expression in queries 

WhizAI supports NLQs that contain the expression 'my'. You can use the ‘my’ expression in your queries in 

the following scenarios: 

 

There are three  ways to customize MY metadata:  

1. Rosters (User defaults) 

2. My configuration 

3. Authorization 

 
● You can add and configure a data model, where you (user) are part of the source data. For more 

information, refer to the following example of source data. 
Source data example: 
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Invoice Creator Approver 

User A C B 

User B (You) A B 

User C B A 

 

Example NLQs:  

• Show me invoices approved by me',  
• 'Show me invoices where I am the creator' etc. 

 Ambiguous queries are not supported. For example: ‘Show me my invoices’. 

 

● You can add and configure a data model, where entities (product, region etc.) from source data are 
mapped to you (to the user). For more information, refer to the following example of source data. 

 

Source data example: 
 

User Product Region TRx 

A Trexine Northeast 100 

B (You) Plabenil West 500 

B (You) Trexine West 600 

C Crestor Midwest 300 

C Crestor South 300 

 

Example NLQs: ' 

• Show me sales trend in my region', ' 
• Show me TRx for my product', ' 
• How is my product growth for last month?',  

• 'Show my top performing product’ etc. 

 Note! 'My metric' or 'My performance' queries are not supported, only 'My Metadata' queries (for 
example: my product, my region, etc.) are supported. 

 

Example query 1: Show me TRx for my product 
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Example query 2: What is the sales trend in my region? 
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If my metadata is not set up using any of the methods mentioned above, the system will treat the entire 
dataset as my data and give a valid response as shown below: 

  

Example query : My products 
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NLQs - Smart Search for Searching and adding entities to queries 

We have introduced Smart Search in the conversation box on WhizAI Explorer. Smart Search allows you to 
search and add entities to your queries. 
 

 
 

Configuring dimensions for Smart Search 

From the admin console, you can choose the dimension to be enabled for Smart Search. To configure the 

dimension for smart search: 
 

1. Go to WhizAI Admin console > Content Manager > Configurations. 
2. From the dropdown, select the data model for which you want to configure the dimensions. 
3. Go to Dimension Selection For Smart Search and select the desired dimensions from the 

dropdown list. These selected dimensions appear in the Smart Search on Explorer. 
4. Click the Save on the top right corner of the page. 
5. To view these configured dimensions, go to Explorer > Conversation box > Smart Search, and 

click the select icon. 
Configured dimensions are displayed as shown in the following figure. 
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You can search entities from these configured dimensions and add them to your query. For more 

information, refer to the ‘Searching and adding entities to your query’ section. 
 

Selecting default dimension for Smart Search 
 

1. You can select the default dimension to be available for Smart Search. 
2. To set or change the default dimension: 
3. From the WhizAI Admin console go to Content Manager > Configurations. 
4. From the dropdown, select the data model for which you want to select the default dimension. 
5. Go to the Smart Search Default Dimension and select the desired dimension from the dropdown list. 

 

 
 

6. Click the Save option on the top right corner of the page. 

The selected dimension is set as the default search dimension for the Smart Search on Explorer. 
 

Searching and adding entities to your query: 
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1. Go to the Workspace > Conversation box > Search and enter the entity name.  
As you start typing, the search result displays all the entities for the selected dimension. 
 

 
 

2. Select the desired entity from the list, and the selected entity gets added to the query. 
 

 
 

3. Click Enter; WhizAI displays the response to your query and the selected entity gets added to the 
context. You can continue to ask questions about this added entity. 

 

 

NLQs - Enhancing natural language query capabilities 

WhizAI understands and responds to a wider range of NLQs, accurately interpreting your intent no matter 

how you phrase your question. This upgrade highlights the NER Mapping – Metric and Metadata, which 

ensures that extracted entities (e.g., customers, regions, or products) are correctly linked to relevant metrics 

and data fields. Even if you rephrase or restructure a query, the system consistently maps the same entities 

to the right metadata and delivers precise and reliable results every time. 
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For example, if you ask how many emails were clicked in the last quarter by each customer, the system 

recognizes the metric in the question is Email - Clicked and gives you the right response as below: 

  

 
  

In addition to NER mapping, WhizAI has developed a healthcare-specific pre-trained model that 

understands industry-specific language and provides relevant responses. For example, if you ask to provide 

the sales performance of all prescriptions in the west region, it will give you a sales performance of all three 

metrics – TRx, NRx, and NBRx. 
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NLQs - Supporting custom period (cycle) 

WhizAI now supports custom periods, cycle (similar to month, year, week) in the NLQs.  

The custom time period is represented by a name and duration based on the customer's requirements. For 

example, one cycle can be 5 weeks in the year. This time period (cycle)  can be used in NLQs as a 

standalone expression or can be used with other time periods as well.  

  

Some examples are as below. 

• Show me this year by cycle 

 
  

• cycle1 2022 vs cycle2 2022 

 

 
 

 Some more NLQ examples are as below: 

  

• sales for first cycle of 2024 

• compare cycle 1 yoy 

• Compare C1 yoy (C1 means cycle 1) 

• cycle 1 vs cycle 2 by brands 

• compare 2023 and 2024 by cycles 

• show me sales for first cycle of each year 

• show me sales for previous cycle 
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NLQs – Support previous YTD (PYTD) expressions 

WhizAI makes trend analysis even smarter with support for Year-to-Date (YTD) comparisons for previous 

years! With the new Previous Year to Date feature, you can easily see how your current performance stacks 

up against the same period in previous years. This powerful addition brings deeper insights, helping you 

spot trends, patterns, and growth opportunities faster than ever. Now, analyzing year-over-year 

performance is not only more efficient but also more impactful for your decision-making! 

  

For example, if you ask a query YTD TRx across last 5 years, the system will provide TRx for last 4 years along 

with the latest one.  

  

Some examples are as below: 

• YTD of current 2 years 

  

 
• 2022 YTD vs 2021 YTD 

 
• Compare 2022 vs 2021 YTD 
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For multi-time queries, each time dimension may return different results based on the dataset. This means 

the records from each dataset might not match. In these cases, pagination and sorting is controlled by the 

first time period, and the response is aligned accordingly. If you sort on another time period (column), you 

get a different result set. Refer to example below: 

 

Example query 1: ytd, last year ytd by customers for territory boston south 

 

With YTD sorting, you will get 19 records and with sorting on Last Year YTD, you will get 24 records. 
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NLQs - Support for excluding as an expression 

WhizAI understands the usage of excluding expressions without accompanying the dimension and you will 
get the correct results.  

  

For example, you can ask a query to show Trx by products excluding Arobi and you will get result 
accordingly.  
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NLQs - Support for AND operators in multi-expression queries 

 
WhizAI supports the use of AND operators in queries that involve multiple metrics or dimensions, offering 
flexibility in complex data requests. This feature enables users to combine different conditions or criteria 
within a single query for more comprehensive insights. For further details, users can explore the provided 
examples to understand how to apply the AND operator effectively. 

 
●       Trend of Arobi and Trexine and Plabenil 
●       TRx and NRx for Trexine vs Plabenil by brands by regions 
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Pinboards 

Pinboards are containers where you can attach/bookmark your important or favorite responses. Later, you 

can refer to these pinned responses or cards to view the updated details. 
 

WhizAI provides My Pins as a default pinboard. You can create new pinboards, as required, and attach 

your responses to these boards. 
 

WhizAI provides options to manage your boards, that is you can add a board, edit a board’s name, delete a 

board, edit a board’s layout to arrange the cards, and share the board with other users. For more 

information, see Board Settings. 
 

When you try to pin a response to your board, the list of available boards appears. You can select a board 

to which you want to add that response. For more information, see Pinning a response message. 
 

 Note: The last pinned response always appears at the top of the pinboard. For more information on 
pinboards, refer to the section Using Pinboards & Cards. 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pinning a Response to Pinboards 

After Viewing a response, you can pin it to a pinboard. This topic provides the steps to pin a response 

message. 
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1. Enter your question in the Conversation box. The Response box displays the response to your 
question. The response can be in the form of text, table, or chart. 

2. Click the Pin Message option available from the response options. 

 

3. Select a board from the available board list.  For more information, see Creating a Pinboard. 

 

 Note! This drop-down list shows all the boards of which you are the "Owners" or "Editors" only. 

 

 

 

4. The pinned message is added to the selected board. 

 

 

 

Using WhizAI on the web 

This chapter explains WhizAI functionality while accessing it from the web. Also, it explains the concepts that 

can be applied to understand the functionality: 

• Overview 
• Using voice to ask the question 
• Viewing a response 
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• Viewing a response in different formats 

• Response Pinning 
 

Before you proceed, understand the following concepts: 

• Context 
• Follow on 
• Disambiguation 

Context 

WhizAI is enabled with context establishment. When you ask a question, WhizAI identifies the context of the 

conversation and remembers it so that you don’t have to repeat common things such as the metrics and 

filters previously used in your question. 
 

Example: 
 

If you ask WhizAI: Show me the TRx count for California. WhizAI will show you the response for this, 

however, it will identify California as the context and remember it for your next question.  
 

 
 

Example  

Suppose you ask the question “Show me top 10 performing accounts” and get the following response: 
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Suppose you do not want the context and wish to start over again. In this case, you need to reset the context 

and ask your question again. You can reset the context by entering the Reset command or clicking the 

Reset icon  from the Conversation box. Also, if you want to reset a specific dimension in the context, you 

can enter the command “Reset <dimension name>.” 

Follow Up 

‘Follow up’ is an option that WhizAI provides to drill down a response to get more insights.  

 Note: The result of the follow-on may vary depending on the customizations done on WhizAI. 

 

Hover on the data point and click Follow up from the pop-up menu and know more details.  

Example 

If you ask the question, “Top regions by TRx”, Hover on any data point and click Follow up from the pop-up 

menu 
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The response is further drilled down to top 25 districts for Mid-Central as shown below: 
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According to your input, WhizAI drills-down the on the result and shows the corresponding data details. 

 

Disambiguation 

Disambiguation is a feature by which WhizAI identifies the ambiguous terms in your questions and suggests 

options to clarify those terms. Ambiguous terms in a question may have multiple meanings because of 

which WhizAI is unable to confirm the question and give a correct response. 

 Note! WhizAI supports identifying multiple ambiguous terms in the same question. Also, these 
ambiguous terms can be a metric name or dimension name. 

If you ask WhizAI a question about an entity for which you do not have authorization, the system validates if 

you are authorized to view the details for that particular entity and then responds with a message stating 

you are not authorized to view the details for that particular entity. Let us consider the following: 

● If you do not have authorization to view details for ‘Germany’ and you ask a question regarding 

Germany, in this case, the system shows the message.  

● If you have the authorization to view data for ‘Cluster: Germany’ and ‘Country: Germany’, and you 

ask a question regarding Germany, in this case, the system shows a disambiguation list asking 

you to choose the appropriate value. 

● For entities having hierarchical relations, you shall see data for the hierarchical level lower than 

the authorized entity. 

How WhizAI resolves ambiguation? 

WhizAI, being AI-enabled, suggests options for the identified ambiguous terms. You must manually 

respond to those options so that WhizAI can complete the question and give a correct response. 

Example 

Suppose you ask a question. “Show me sales of California”. 

In this question, WhizAI identifies ambiguity in the word “sales.”  
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To resolve this ambiguity, WhizAI respond with multiple options, as shown below: 
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Here, WhizAI is unable to decide if the Term ‘Sales” is a TRx metric or NRx metric. You can either click any of 

the given options, as required, and click Apply. 
 

Thus, you clear the ambiguity by specifying the meaning of the ambiguous term, as required. Next time, if 

the same term appears again in another question, WhizAI remembers your previous response to 

disambiguation and displays the response accordingly. However, it still takes care by showing appropriate 

warning messages along with the option to clarify the ambiguity again.  
 
 

If the given response is not correct to your question in the context, you can click the View Options link in 

the message and again choose the correct option. 
 

If the response is correct, you can click the Dismiss link to clear the message. In the disambiguation flow, if 

you prefer to see multiple options with equal preference, then in the subsequent query, you must 

disambiguate the terms again from the possible options. 

Smarter disambiguation  

WhizAI optimizes the ambiguity resolution process by leveraging the metrics dimension compatibility 

feature to enhance clarity and responsiveness. In NLQ, when both metrics and dimensions or entities are 

ambiguous, the system will first present options to resolve the metric ambiguity. Once the metric ambiguity 

is resolved, the system will then display a list of compatible ambiguous dimensions and entities for 
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further resolution. This streamlined approach ensures a more efficient query response, minimizing user 

clicks and improving overall user experience.   

 

Refer to the below use case: 

• Metric - Sales (Reach, TRx)  
• Reach which is incompatible with Territory, Products.  

You will get responses  for the NLQs as below: 

 
• Show me reach for Boston 

In this example, Boston is a territory and a district. As Reach is compatible only with the district, the system 

will understand that you are asking for reach in Boston district and respond without asking you to resolve 

the Boston ambiguity.  

 

 

• Show me sales for Houston 

In this example, sales has ambiguity with TRx and Reach metrics. The system will first ask you to resolve 

the metrics ambiguity as shown below: 
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Click VIEW OPTIONS 

 

 
 

If you select TRx metric, you will be asked to 
resolve the next ambiguity Houston shown 
below.  
 

 If you select Reach metric, you will be asked to 
resolve the next ambiguity Houston shown 
below.  
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Notifications 

 
 

In the Notifications area, you can view all the notifications. The Notifications section displays the name of 
the user along with the corresponding message.  
 

In this section, you see notifications when  

• a pinboard or card is shared with you  
• a response is shared from the explorer if the ownership of the board is transferred to you 
• the access to a board is revoked,  

•  you are assigned editing rights to a board or these rights are revoked,  
• the board is shared with a user group and you are a member of that group. 

 

You can configure WhizAI so that you receive alert notifications while you are logged in on MS Teams. On 

receiving such an alert, you can click it to view the corresponding response. 

 Remember! It is required that you have all the following accounts: WhizAI account, MS-Teams 
account, and Whiz Teams client ID. 
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Alerts  

You can organize all your alerts under one roof with the Alerts menu with multiple data models in the drop-

down menu. 

When an alert condition is validated, all designated users will receive notifications as per their permissions., 

and they will have the option to view all records that meet the condition. Enhanced backend infrastructure 

and validation checks have been implemented to guarantee reliable notification delivery and 

comprehensive data access.  
 

 
 

Now you can group all your alerts according to data models (for example, Field Analytics). 
 

 Note! The data model name is always displayed at the end of the alert message. 

 

 Remember! Alert notifications are closely aligned with your individual context and roster defaults 
(refer to the image below). 

 

 
 

As seen in the above figure, TRx and Mid Atlantic are selected from your roster's defaults. 



Understanding WhizAI User Interface 

 

 

134 of 315 

The alert notifications are directed to you based on a precise match between the context of the alert and 

your personalized roster defaults. This means that you will receive only those alerts that are directly relevant 

to your specific responsibilities and tasks as defined in your roster settings. 
 

This roster alerts guarantees that your alert notifications remain targeted, enabling you to focus exclusively 

on the alerts that matter within your scope. 
 

The Alerts section shows messages about changes such as an increase/ decrease in metrics or an alert 
message pertaining to your role change. On the bell icon, you can view the count of new notifications in red 
color. This count indicates the number of new notifications you have received. Along with this, WhizAI 
flashes a tip that shows the notification message. You can always click the bell icon to view the notifications. 
 

After you log in, WhizAI asks for permission to show notifications. If you click Yes, then WhizAI shows you a 

notification when you are in a different tab, i.e. this notification is received when the browser tab in which 

WhizAI is open is inactive. For example, WhizAI displays a notification when another user shares a pinboard 

with you. 

 Note! This notification is a clickable link. You can click the link to open the shared pinboard. 

Alert Manager - How It Works (For Admin Users) 

The Alert Manager allows admin users to schedule single or multiple alerts across selected data models in 

addition to data load triggers.  

Following are the details for the Alert Manager: 

 

1. Accessing the Alert Manager: 

• Login as an Admin user. 

• Click the Alerts tab on the top navigation bar of the interface. 

• Click Alert Manager to view the list of existing alerts. 

• Under Data Model column, click  to filter the list of data models. 

2. Viewing Existing Alerts: 

• The alert list displays critical information such as: 

o Alert Name: Name of the alert. 

o Last Triggered At: The most recent time the alert was executed. 

o Last Triggered Status: Displays the outcome of the last alert execution, either "Success" or 

"Failed". 

o Data Model: The data model corresponding to the alert. 

o Trigger on Data load: You can disable automatic alert triggering each time data load is 

ingested. 

▪ The Enabled  toggle allows you to trigger alerts when data load is ingested. 
o Schedule: Displays whether a recurrence field of the schedule set (daily, weekly, etc.), or 

"None" if not scheduled. 

o Trigger: Allows manual launching of the alert with a Launch button. 

o Subscribe: Enables users to toggle subscriptions to the alert. 

o Enabled: A toggle to enable or disable the alert. 
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3. Creating or Editing Alerts: 

• To create a new alert, click on the Scheduler button. 

• To edit an existing alert: 

o Click the pencil icon in the Actions column to modify the alert details, parameters, and 

conditions. 

o Update schedules, criteria, and alert triggers as needed. 

4. Launching Alerts: 

• Admin users can manually launch an alert at any time by clicking the Launch button in the Trigger 

column. 

• This is helpful if an immediate execution of an alert is needed outside of its regular schedule. 

5. Trigger Alerts on Data Load:  

• You can disable automatic alert triggering each time data load is ingested.  

• The Enabled  toggle allows you to trigger alerts when data load is ingested. 
 

6.  Scheduling Alerts: 

• You can set a specific time and frequency for alerts by configuring the schedule. Click on the 

Scheduler button to define the frequency(e.g., daily, weekly, monthly). 

• Alerts without schedules will display "None" in the Schedule column. 

7. Enable/Disable Alerts: 

• The Enabled toggle allows you to activate or deactivate an alert. 

• If an alert is not required temporarily, switch it off to prevent it from being triggered. 

• Disabled alerts cannot be triggered manually, by data load, or through schedulers.  

8. Subscriptions: 

• Alerts can be subscribed to by other users, meaning they will receive notifications when the alert is 

triggered. 

• Admin users can manage their subscription preferences by toggling the Subscribe switch. 

9. Managing Actions: 

• Edit: Click on the pencil icon to update an alert’s settings. 

• Delete: Click on the trash icon to permanently remove an alert from the system. 

10. Monitoring Alert Execution: 

• The Last Triggered At and Last Triggered Status columns help monitor when the alert was last 

executed and whether it was successful. 

• If an alert fails, the status will be "Failed," and you may need to investigate the cause by reviewing 

the alert settings or logs 

Steps to Add a Scheduler from Alerts Manager as Administrator 

To add a scheduler for alerts in the Alert Manager, follow these steps: 
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1. Open the Scheduler: 

o Click the Alerts tab at the top of the screen > Alert Manager > Scheduler button located at 

the top right corner of the Alerts Manager page to open the scheduler window. 

o The scheduler window will display the current schedules and their details, including the alert 

name, last run time, and last run status. 

 

2. Add a New Schedule: 

o Click the + Add button in the scheduler window (as shown in the image). 

o This will prompt you to configure a new schedule for the selected alert. 
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3. Configure the Schedule: 

o Data Model: Ensure the correct data model/s are selected for the alert. 

Note! When multiple data models are selected, the enabled alerts from all those selected 

models are launched on the scheduled time. 

o Date & Time: Choose the date and time when the alert should be triggered. 

o Recurrence: Set the frequency for how often the alert should trigger (e.g., daily, weekly, 

monthly, do not repeat etc. ) 

4. Save the Schedule: 

o Once you've set the desired date, time, and frequency, click OK to confirm and activate the 

schedule. 

5. View or Edit Existing Schedules: 

o To view or modify existing schedules, click the pencil icon under the Actions column to edit 

the schedule. 

o You can delete a schedule by clicking the trash icon. 

6. Complete Scheduling: 

o After adding or updating schedules, click OK to close the scheduler window and return to 

the main Alerts Manager page. 

Your alerts will now trigger automatically based on the configured schedule, without the need for 

manual activation. 

 

Steps to Add a Scheduler from Alerts Manager as User 

To add a scheduler for alerts in the Alert Manager, follow these steps: 
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1. Open the Scheduler: 

o Click the Alerts tab at the top of the screen > Alert Manager > click the None hyperlink 

under the Schedule column for the Alert you wish to schedule.  

o The scheduler window will display the current schedules and their details, including the user 

who created the schedule, last run time, and last run status. 

 

2. Add a New Schedule: 

o Click the + Add button in the scheduler window (as shown in the image). 

o This will prompt you to configure a new schedule for the selected alert. 
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3. Configure the Schedule: 

o Date & Time: Choose the date and time when the alert should be triggered. 

o Recurrence: Set the frequency for how often the alert should trigger (e.g., daily, weekly, 

monthly, do not repeat etc. ) 

 Note! For Admin User you can configure Data Model: Ensure the correct data model/s are 
selected for the alert. When multiple data models are selected, the enabled alerts from all those 
selected models are launched on the scheduled time. 

4. Save the Schedule: 

o Once you've set the desired date, time, and frequency, click OK to confirm and activate the 

schedule. 

 

5. View or Edit Existing Schedules: 

o To view or modify existing schedules, click the pencil icon under the Actions column to edit 

the schedule. 

o You can delete a schedule by clicking the trash icon. 
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6. Complete Scheduling: 

o After adding or updating schedules, click OK to close the scheduler window and return to 

the main Alerts Manager page. 

Your alerts will now trigger automatically based on the configured schedule, without the need for 

manual activation. 

 

Creating condition-based alerts from a Response 

You can configure alerts from the responses on WhizAI Explorer or from the cards on pinboards. With this 

functionality, you can define a condition, and if the data reflects that the configured condition is satisfied, an 

alert notification is triggered. 
 

For example, you may configure an alert to be triggered when the TRx market share drops by 1%. 

As soon as the data suggests this drop, the recipient(s) receive an alert notification. 
 

Alerts can be enabled for each data refresh. Also, you can subscribe or unsubscribe from alerts and choose 

to receive the alert notifications through the web or email, depending on your preferences. 
 

Let’s consider an example where you have asked WhizAI 'Top regions by TRx' and you want to create an 

alert from the generated response. 
 

To create an alert: 

1. Click the Create Alert icon  
 

 
 

OR 
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Hover the cursor on the data point for which you want to create an alert, and then click the vertical 

ellipsis icon  > Create Alert. The alert configuration dialog is displayed. 
 

 
 

2. On the alert configuration dialog, give the appropriate name for the alert. 
 

 

 Note! The scope for the alert is retrieved from the query. Also, the time period can be changed.  
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 Note! You can use the Filter By option to drill down or roll up for the retrieved scope to set the 
condition. 

 

3. In the Conditions section, you must add and define a condition that shall trigger the alert. 
 

 
 

If you have multiple metrics in your question, for example, if you ask show me top regions by TRx, NRx: 
 

 
 

 
To define alert condition: 

a. Select a metric from the dropdown. You can add multiple conditions using the AND/OR 
options. 
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o Note! If the AND condition is selected, it means that all three conditions must be satisfied. If 
the OR operator is selected, it means either one of the conditions must be met to trigger the 
alert. 

b. Select the Operator and enter metric Value as required. 
You can compare between two metrics, for example, ‘If TRx equal to NRx’, trigger an alert. 
This is called a Metric alert.  
OR 
Select the metric from the drop-down, select the operator, and then enter a value at which 
you want to trigger an alert. This is called a Value alert. 
 

4. Click Next. The Delivery Method configuration options are displayed. 
 

5. To define the alert delivery method: 
a. Select Alert Channel. You can select Web or Email or both. Alerts will be delivered through 

the selected channel(s). 
b. Alert Message is auto configured with defined condition(s)/scope. You can customize this 

message as required. 
c. Select Action for your alert. You can select either Explorer, Pinboard, or N/A. 

• Explorer: If you select Explorer, you must add the query in the Natural Language 
Query field. When you open the alert notification, this query gets triggered on 
Explorer. 

• Pinboard: You have to select the pinboard from the dropdown, When you open the 
alert notification, this pinboard is opened. 

• N/A: No action taken, when you open the alert notification. 

 

 
 

6. Click Next. Options to select recipients are displayed. 
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 Note! To enable the recipients' section, you need to configure it. For more details refer to the topic 
Configuring recipients for alerts in the WhizAI Configuration guide. 

7. Choose the recipients with whom you want to share the alert with. 

 Note! You can select user groups to share the alert with users within that group. 

 
 

8. Click Create. WhizAI displays the message ‘<Alert name> Alert successfully created’. 
 

9. For alert management, go to Profile > Alerts > Alerts Manager . You can see the alert(s) created by 
you. 
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 Note! You can Subscribe or Unsubscribe from the alerts directly through the user 
interface. 

 

 Note! The launch option is used when you want to send out customized message 
alerts for a set of users or user groups for a special update. 

 

 Note! From the Actions column you can edit or delete the alerts. 

Below are a few more examples of Alerts: 

● TRX Trend for Arobi or TRX for Arobi (Alert on a metric with filter) 

● TRX by region for Plabenil (Alert on a metric affecting all regions) 

● Arobi vs Plabenil (Alert on comparison between two entities) 

● TRX Growth, NRX growth by region for Arobi (Alert comparing two different metrics of the 

same scope) 

● TRX PoP for Arobi (Alert comparing metrics across different periods) 

 

Create custom alerts using script 

WhizAI now enables you to create customized alerts using existing alert creation functionality by selecting 
the Script as a condition. Complex conditions can now be handled using script-based alerts. 
 

 Follow the below steps to create and enable script-based alerts. 
1. To create script-based alerts 
2. To create the script using Editor. 
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Setup Script-based Alerts 
 

• Create a new alert from Explorer or Pinboard. Click Alerts -> Alerts Manager and create a new 
alert.  

• Enter alert name, Scope, and Filter By 
• Select the Script radio button and select the desired script from the drop-down list. 

 

 
 

• Click Next and complete the alert setup. 
 

 Note! When defining the script, the alert message will be generated based on the 
toggle switch status (enabled or disabled). If the toggle switch is disabled, the default message will 
be displayed. 

If the script is generating the message, the message box is disabled.  
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Access control on alert notification actions 

You may not have access to the Explorer or pinboard section. When an alert notification redirects you to 

these areas, the information is not displayed, leading to confusion about the content. To avoid such issues, 

below access controls measures are implemented on the Alert page. 

• Changes to Action drop-down list 
a. If you do not have access to Explorer, the Action drop-down list will show only Not 

Applicable and Pinboard.  
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b. If you do not have access to Pinboards, the Action drop-down list will show only Not 

Applicable and Explorer.  

 

 
c.  If you do not have access to both Explorer and Pinboard, Action column is disabled. 

 

 
 

• Changes to alert notification  
If you do not  access the action (Explorer or Pinboard) specified in the alert, the hyperlink on the 
individual alert message and the rows in the grouped alert popup are disabled. 
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Alerts audit log 

Alert management and actions on alerts are tracked in the system. Below information is captured as part of 

the audit log.  

 

Alert Management (Create/Edit) 

• Unique Alert id 

• Alert name 

• Request Id 

• Operation type - Create/Update/Delete 

• Created by 

• Last modified by 

• Creation timestamp 

• Last modified timestamp 

• Entire new alert object - Scope, Filter, condition, message format, channel, receivers etc. 

 

Alert Management (Delete) 

• Unique Alert id 

• Alert name 

• Request Id 

• Operation type - Delete 

 

Actions on alert 

• Enabled / Disable 

o Unique Alert id 

o Alert name 

o Request Id 

o Action - Enabled/Disable 

o Last modified by 

o Last modified timestamp 

• Subscribe / Unsubscribe 
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o Unique Alert id 

o Alert name 

o Request Id 

o Action - Subscribe/Unsubscribe 

o Last modified by 

o Last modified timestamp 

• Triggering the alert (Via data load or Launch) 

o Unique Alert id 

o Alert name 

o Request Id 

o Source - Data Load / Launch 

o User Id 

o Timestamp 

o Success/Failure 

o List of users notified 

o Web Channel - Success/Failure/NA 

o Email Channel - Success/Failure/NA 

 

You can view the audit log from the Admin module 

 

Audit log for Visualization actions 

WhizAI logs all the user actions on the Admin module. The audit log will have key components such as 

event logging, username, and timestamping details. The audit log will help analyze the user actions and 

provide insights on important actions on Explorer & Pinboard module. The visualization logs is listed under 

the Explorer and Pinboard modules in the  Audit Log. 

Below visualization activities  will be logged in the audit log: 

 



Understanding WhizAI User Interface 

 

 

151 of 315 

Workspace Module Info icon 

Info icon - Copy query 

Column reorder 

Column wrap 

Model-info View 

Model-info : Switch business category 

Model-info : Sample query click 

Smart search 

Smart search- Select dimension 

Card expand 

Card Image export 

Product help 

What's new content 

Profile settings 

About us 

Notification 

Pinboard Module Pinboard filters hide 

Section filter addition 

Section filter lock 

Card filter lock 

Board Navigation : Favourites 

Pinboard Navigation : Recent 

Pinboard Navigation : My Pinboards 

Pinboard Navigation : Shared with Me 

Pinboard Navigation : All Pinboards 

Pinboard Navigation : Labels 
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Pinboard Navigation : Select Label 

Pinboard Navigation : Pinboard Manager 

Pinboard Info 

Section Expand 

Section Collapse 

Card default view 

Card scroll view 

Summarize this Board -> Refresh the Pinboard Summary 

Summarize this Board -> Expand 

Design Mode 

Pinboard narratives 

Add filter 

View Narratives 

 

Slot Filling for incomplete queries  

In case you enter incomplete information in your query, to complete the query, WhizAI intelligently displays 

a prompt containing probable data values. You can choose from these data values and fill in the incomplete 

details in your query so that a correct data response can be rendered.  
 

For example, if you ask a question, Show me TRx market share. (Without adding information of the brand for 

which this data is required.) In this case, WhizAI prompts you to complete the query by adding the 

information of the brands for which TRx market share should be displayed, as shown in the following figure: 
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Channel Portability 

You can access WhizAI from multiple channels. In all the channels WhizAI offers similar experiences, based 

on the framework supported by the corresponding channel. With the support of multiple channels, it is 

possible that you begin conversation with WhizAI in one channel but shift to another channel in between 

and continue the work from that new channel. Considering this scenario WhizAI is designed and developed 

as a platform that retains the last interactions and responses so that you can refer to these interactions on 

any new channel and work without losing the context of the interaction with WhizAI. 
 

Using WhizAI with Microsoft Teams 

On the web interface, ask WhizAI the following question: 

 “Show me top 10 accounts in Boston ma”. Based on the data, you may get the following response: 
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Now, you shift to another interface, like Microsoft Teams, and enter the command context. In Microsoft 

Teams, you can see that Boston MA is present in the context. 
 

 

Asking a question 

● Enter your question in the Conversation box. For example: Show me the top 10 accounts by cases. 

● (Optional) Use the Voice option to specify the question. For more information, see Using voice to ask 
the question. 

● After specifying your question, press Enter on your keyboard. WhizAI displays the response in either 
text, table, or chart format. 
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● As you enter your questions in the Conversation box, WhizAI provides real-time assistance in the 
following ways: 

 

● Entity suggestions to help you build your query. When typing your questions, when you enter a few 
letters of any entity name, WhizAI suggests the matching entities. You can click on these 
suggestions, as required, to add them to your query. These suggestions include dimensions, 
metrics, and computations available in the selected data model. 

 

 
 

● Predictive suggestions for the next word: 
When typing your questions, when you add a ‘space’ after a word, WhizAI suggests words that you 
can use to complete the question. 
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● Spell checks: 
When typing your question, if you mistype or misspell a word, the NLP engine identifies such words 
and then marks and underlines it with a red line.  

 

 
 

You can click the word to get a list of suggested correct spellings. 
All these suggestions help you in the process of typing a query by offering relevant suggestions as 
you type. This reduces the time and effort required to enter the complete query, especially for 
longer or complex queries. Thus, these suggestions help you to frame your queries more precisely. 
These suggestions can also be helpful for users who are less familiar with or have limited experience 
with entities from the data model. 

 

You can manage (enable/disable) these features from Admin console > Content Manager > 
Configurations. 
 

 
 

Also, when you submit your query with a misspelled word, entity name, or with an entity name that is not 
part of the data model or with incomplete details, in this case, WhizAI assists you in the following ways: 
 

● If you submit a query with a misspelled word or with a misspelled entity name; in this case, WhizAI 
displays a message “We did not understand: "<misspelled word or entity name>". Along with this 
message, WhizAI provides a response considering the other entities, metrics from the query. See 
below example: 
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In the above example, top regions by brands are displayed. 

 Note! If there are no entities/metrics in the query, WhizAI considers the entities/metrics from 
the context and delivers the response. 

 

● If you submit a query with incomplete details, in this case, WhizAI displays a message “Your query 
looks incomplete. We need more inputs to resolve your question .". Along with this message, 
WhizAI provides a few options. You can select from these options and complete the question. 
 

 

Using voice to ask a question 

WhizAI provides a voice input option to enter your question by speaking in the English language. 

 Note: Ensure that you have configured your microphone in the browser in which you are accessing 
WhizAI. 



Understanding WhizAI User Interface 

 

 

158 of 315 

1. From the Conversation box, click and hold the Voice Input icon . The icon changes to red color 
and WhizAI shows a message as shown in the following figure:   

 

 Note! You must hold the click till you finish speaking your question. 

 

2. Ask your question. The words you speak are reflected in the Question area.  

Viewing the response 

1. In the Conversation box, enter a question for which you want to see the response and press Enter. 

The Response box displays a response to your question. For each response, you can view different 
information (Viewing response in different formats) and perform different tasks (Response Pinning) on 
the response. 

 

In a comparison response, the percentage (%) increase or decrease in values are indicated by arrows and 
colored numbers as shown in the following figure: 

● Green color indicates a rise in percentage change or absolute change compared to previous values. 

● Red color indicates a fall in percentage change or absolute change compared to previous values. 



Understanding WhizAI User Interface 

 

 

159 of 315 

 
 

Also, in a comparison response, WhizAI shows the percentage value instead of only numbers.  Also, large 
numbers are shortened with abbreviations, for example, 1,163,310 is displayed as 1.1 M or 447,334--> 
447K. 

 

 

Switching between multi-calendars  

You can configure and switch between different calendar types to tailor responses based on specific 

requirements. 

To configure the default calendar: 

1. Navigate to Content Manager > Configurations > Data Model > Data Modelling (Default 

Calendar). 
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2. Choose the calendar type suited to your needs. 

Available calendar options include: 

• Gregorian: The standard calendar format. 

• Custom: A configurable format where the week runs from Saturday to Friday. 

• Cycle: A format where five weeks form a single cycle. 

This flexibility ensures responses align with your organization's preferred calendar system. 

Viewing response in different formats 

WhizAI has options to change the format in which you can view a response. Below the response, WhizAI lists 

the different visualization formats available for a particular response. Broadly, you can change the format 

from table to chart and vice versa. The highlighted display format (‘Table’ in the following image) is the 

format in which the platform has responded. You can select a different option, as required, to view more 

display formats.  

 
 

For example: 

                             
 

In chart format, WhizAI supports various chart types, like, bar chart, treemap, column chart, pie chart, Pareto 

chart, donut chart, bubble chart, stack chart, full-stack chart, map chart, variwide chart, radial chart, and so 

on. The chart options are shown for the response fully depends on the nature of the query and the 

prediction from the visualization AI model about its suitability score.  

Exporting a Response to MS-Excel or XLS format 

You can export to MS- Excel the following:  

• Tabular responses from WhizAI Explorer 

• Cards having tabular data from pinboards  

The exported Excel file contains all the data exactly as seen on WhizAI UI, i.e. as seen in the response or the 

card in the pinboard. Post the export, you can perform all operations supported in MS Excel.  

 Note! You can export responses with single dimensions to XLS. For example, if you ask WhizAI the 
question: Show me top regions for TRx. In this case, the response contains a single dimension and 
WhizAI allows you to export this response to XLS. 
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Comparing data in a Response 

If you have more than two entities in a response within Explorer or in a card within a pinboard, you can 

select one of these entities as a base metric to compare with the other two for absolute and percentage 

change. You can compare the hierarchical as well as non-hierarchical entities. For example: if you ask 

WhizAI:  

● Compare Boston MA vs Chicago IL vs Philadelphia by months  

● Compare Boston MA, Chicago IL, Philadelphia by months 

● Boston MA, Chicago IL, Philadelphia comparison by months 

Viewing List of Suggested Queries on Explorer 

After you ask a query to WhizAI, you can see a list of suggested queries on Explorer. 

Currently, this list of suggestions is drawn from the query history of a particular user. These are queries that 

might guide or be helpful for you. You can click any of these queries to generate the corresponding 

response. 

Viewing Narratives along with a Response 

Now, when you ask a query, along with the response, WhizAI also provides text narratives from your data. 

These narratives prove to help derive meaningful insights from the data shown in the response. They guide 

you in making informed decisions. 

Narratives - Viewing card level narratives on pinboards 

You can view card-level narratives on pinboards. 
 

 

To view the narratives: 

1. Click the  Expand icon from the top-right corner on the card. The card is displayed in fullscreen. 
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2. Click the Explain > enable the 'Narratives' toggle as shown in the following figure. The Narratives 
are displayed under the Narratives panel on the right. 
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Summarize Board Narratives 

Summarize Board Narratives displays a comprehensive summary of Pinboard narratives. This allows you to 

instantly summarize complex pinboards on-demand and extract key insights from dense datasets 

effortlessly, saving time and effort in data analysis. 

To Summarize Board Narratives: 

1. Click Summarize This Board link on the top-right corner of the Pinboards page. 
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2. The narratives summary is generated as below: 
 

 

Narratives - Exporting narratives as a part of card 

When you export a pinboard to PDF or PPT format, you can export the narratives too along with the cards 
on the board. To export the narratives: 

1. Open the pinboard and click  icon, then click Export. 
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2. Select the Narratives checkbox as shown in the following figure and then click Export. 

 

 
 

 Note! You can export the Narratives along with the cards in Save as a PDF or Save as a PPT format. 
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Introducing Business Data Descriptions 

Business Data Descriptions are brief descriptions of dimensions and metrics. These descriptions provide 
basic and important information about the dimensions and metrics in the configured data model. Refer to 
the following table for examples of Business Data Descriptions. 
 

Dimension / Metric Description 

Product Any medicine intended for human use, presented in its finished dosage form is subject 
to control by pharmaceutical legislation (registered). 

NRx A new prescription, defined as dispensed prescriptions given a new number by the 
pharmacy, is not necessarily new therapy for the patient. 

TRx 

 Abbreviation of total prescriptions. TRx = NRx + Refills. After the first time a 
prescription is filled, when it is refilled, the pharmacy refers to the previous drug ID 
number and notes this as a refill. 

NBRx New brand prescriptions. 

 

 Note: Business Data Descriptions are specific to the data model that is selected. 

 

Business Data Descriptions are displayed on the user interface when you hover the cursor on a 

dimension/metric on the Info page or when you click on the Info option  on the response. For more 
information on how to access data descriptions, refer to the following sections. 
 

Accessing Business Data Descriptions on the Info page 

The Info page displays a list of all the dimensions and metrics configured for the selected data model. You 
can access descriptions for these dimensions and metrics. 
 

To access Business Data Descriptions: 
 

1. On the conversation box on WhizAI explorer, click Info. 
 

 
 

The following data model information page appears. 
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2. Hover the cursor over any dimension or metric, and the Data Description is displayed as a tooltip. 

Restricted access to dimensions based on authorization 

WhizAI Administrators can set authorization for users so that they cannot view specific dimensions in the 
entire product. Such users can view the details for the rest of the dimensions, except these ‘hidden’ 
dimensions. In case you are not authorized to view certain (hidden) dimensions, then, you get a 
corresponding message on WhizAI Explorer and on the cards on the pinboard. 

 Note! For more information on how to restrict the dimension access, please refer to the Users and 
Security article, Authorization section. 

Viewing Example Queries for each business category on the Model Info page 

Example Queries on the Info page is categorized according to the business categories on the Info page. 
For more information, refer to the following figures. 
 

Example Queries for All business categories: 
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Example Queries for the business category Activity: 
 

 
 

Example Queries for the business category Sales: 
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Example Conversations panel on Explorer 

A configurable Example Conversations panel is available in the Explorer workspace, offering users pre-

defined queries that serve as starting points for common analysis tasks. Administrators can set the display 

location of this panel—either in the Explorer or Info panel—through a new configuration option. 

A configurable Example Conversations panel in the Explorer workspace helps users start their analysis 

with predefined queries. It serves as a starting point for common analysis questions. 

 

 Note! Administrators can set the display location of this panel either on the Explorer or Model  

Info panel.  

 

When a user clicks on a query from this panel, the context resets before generating the response in the 

Explorer, ensuring accurate results 
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If you click What are my sales trend over week? The context will reset and the response is generated. 

 
 

Example Queries on the Example Conversations panel is categorized according to the business 

categories such as Activity, Sales, Speaker Program, Misc etc. 
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Accessing Business Data Descriptions from a response 

You can access the descriptions of dimensions and metrics which are in the card context of the response, 
these descriptions help better comprehend the dimensions and metrics in the card context response. To 
access business data descriptions: 
 

1. On the NLQ response, click on the Info icon. A new Information window appears. This window 
displays descriptions of metrics and dimension metadata from the response. 
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To view definitions associated with dimension metadata, click Dimension. 
 

 
 

For more information on how to use these options, refer to the Business Data Descriptions document: 
support@whiz.ai 
 

 Note: For optimal performance, it is advised that a description of the dimension or a metric should 
contain 255 characters only. 

 

mailto:support@whiz.ai
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Viewing the NLQ on the card 

You can view the original query on the card that was used for generating the response. Therefore, if you 

want to regenerate the response using the original query, you can copy it from the Information dialog of the 

card and paste it into the context. For example, when you ask WhizAI ‘Show me top growing regions’ then 

you get the following response. 
 

 
 

When you click the ‘Info’ icon the Information dialog opens where you can see the Original Query as 

shown in the following figure. 
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You can click Copy and Paste in the context to regenerate the response. 

 

 

Hyperlinked Card Query - Integration of Pinboards and Explorer Environments 

The original query that you see in the response > Info icon > Information dialog is hyperlinked, that is, if 
you click the query, WhizAI Explorer opens in a new tab and the response is regenerated for the query - 
without having to manually copy and paste the query in the WhizAI Explorer. 
 

It simplifies navigation to the WhizAI Explorer. Also, when you click the hyperlinked query from the card in a 
pinboard, the pinboard data model is passed to Explorer. 
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Using Pinboards & Cards 

 Note! Pinboards and cards show only the data for which you have authorization. You may see cards 
in pinboards with a message that says: “You are not authorized to view this data”. This is the case when 
the card contains data that you are not authorized to view. 

Pinboard Navigator 

You can click the  icon to see the Pinboard Navigator that contains multiple intuitive labels and all the 

pinboards grouped under multiple categories as shown in the following figure: 
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 Tip! You can use the left and right navigation arrows to switch between the boards of your 
preference or navigate between the next or previous boards of the selected category or label. 

 

 
 

When you click the  icon from the main pinboards panel (or from the top-right corner of the Explorer), 

the Pinboard Navigator is displayed that contains the following options: 
 

• + icon that allows you to add a new pinboard 

• Export  and Import  options to migrate the pinboards within environments  

Multiple pinboards grouped under the following categories 

• Favorites - boards that you might want to frequently have a look at, you can pin directly to the 

board, marked as favorites.  
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 Note! From the Explorer top navigation options, when you click , by default the 
pinboard from the Favorites category is displayed. When you click that pinboard’s name or the 
arrow against it, you can see the complete list of the boards in the Favorites category. 

 

• Recent - shows the last accessed and updated board(s) 

• My Pinboards - shows the boards owned by you. 

• Shared with me - list of pinboards shared with you. 

• All Pinboards - list of all the pinboards 

• Labels - labels are tags that group the boards for easy identification. 

• Pinboard Manager - opens the Pinboard Manager page 
 

From the Pinboard Navigator, you can: 

• Create a new pinboard 

• Import or Export a pinboard to move it within different environments 

• Search a board using the search box 

• Navigate to a pinboard by clicking any of the categories (Favorites, Recent Boards, Shared with 

me, My Pinboards, and All Pinboards ) 

• Navigate to a pinboard by clicking Labels. WhizAI shows all the boards associated with a particular 

label. 

• Navigate within the category of the currently opened board. 

Creating a Pinboard 

Method 1: To add a board, from the Pinboard Navigator: 

1. Click  from the main pinboards panel. The Pinboard Navigator is displayed. 
 

 

2. To add a pinboard, click + icon (Create New Pinboard icon). WhizAI displays a dialog to enter a 

name for the board. 
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3. Click Create to add a pinboard. The pinboard gets added. You can access this board from the 
categories on the Pinboard Navigator. 

Method 2: To add a board, from the from the response. 

1. From the top right corner of a response, click the  pin icon. Pinboard Navigator is displayed. 
 

 
 

 Note! This drop-down list shows all the boards of which you are the "Owners" or "Editors" 
only. 

 

2. To add a pinboard, click + icon (Create New Pinboard icon). WhizAI displays a dialog to enter a name for 

the board. 
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 Note ! Create pinboards in the target user's default language to ensure seamless 
functionality. 

3. Click Create & Pin to add a pinboard. The pinboard gets added, opened on the right side of the 
explorer, and the response gets pinned to it. You can access this board from the categories on the 
Pinboard Navigator. 

Or 

If Pinboard Manager is configured for you, then click My pinboards from the left side navigation, 
and from the bottom right side click + Create New Pinboard. 

 
 

1. In the Enter pinboard name field, enter a name for the pinboard, as required. 

2. Click Create. WhizAI creates the new board and opens it as the active pinboard. Also, you can click 
All Pinboards from Explorer to view all the pinboards. 

Search a board using the search box 

1. Go to the Pinboard Navigator and click inside the search box. 
 

2. Type the pinboard name or label name you want to search. The pinboard is displayed below the All 
Pinboards or Labels as per the category. 
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3. Select the pinboard. The pinboard opens in the main pinboards page. 

Navigating to a pinboard  

1. Go to the Pinboard Navigator and click any category you want to select (Favorites, Recent Boards, 
Shared with me, My Pinboards, and All Pinboards). All the boards are displayed on the right side. 

 

 
 

2. You can select the pinboard to open it or open it in JSON. 
 

Navigating to a pinboard from the Labels Category 

 

1. Go to the Pinboard Navigator and click Labels. All the labels are displayed on the right side. 
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2. Click the Label as required. The pinboard(s) associated with the label are displayed. 

 

 
 

 Note! You can select the pinboard to open it or export it in JSON. 

 

 Note! You can search the labels directly from the search box below the Pinboard Navigator 
arranged alphabetically. 

 

 Note! Viewers see the labels of the boards shared with them and owners see the labels of the 
boards created by them. 
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If you access Labels from the Pinboard Manager; along with the pinboards list, additional details are 
displayed on the right side. 
 

 
 

Understanding Owner, Editor, and Viewer rights on Pinboard 

Behavior Board Owner Editor Viewer 

Editing Pinboard name Yes Yes No 

Change the background color, border color, font color, 

font size, and font style of the card 
Yes Yes No 

Changing the layout and card size for pinboards Yes Yes No 

Reorder columns, pin columns, pagination, roll-up, drill-

down, expand all/collapse all 
Yes Yes Yes 

Add annotation/notes in the cards Yes Yes Yes 

Creating sections in pinboard Yes Yes No 

Editing sections in Pinboard Yes Yes No 

Deleting sections in the pinboard Yes Yes No 

Add labels to pinboards Yes Yes No 

Adding filters to Pinboard, Cards and Sections Yes Yes No 

Apply Slicers to the Pinboard Yes Yes Yes 

Apply Cohorts to the Pinboard Yes Yes Yes 

Saving sorting order on cards of pinboard Yes Yes No 

Change card formats at runtime Yes Yes No 

Download data from cards Yes Yes Yes 

Exporting pinboards to PDF or PPT Yes Yes Yes 

Copying pinboards Yes Yes Yes 

Drag and drop filters on the pinboards Yes Yes No 

Setting different reference date on the pinboard Yes Yes No 

Share pinboard Yes No No 
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Renaming cards from the pinboards Yes Yes No 

Adding Cards from Explorer Yes Yes No 

Delete a card/s from pinboards Yes No No 

Delete pinboard Yes No No 

Unfollow pinboard No Yes Yes 
 

Editing Pinboard name 

1. From Explorer, click All Pinboards to open the main pinboard’s layout page. 
2. Open the pinboard to update the pinboard name. 

3. Click the ellipse icon  at the right side of the window screen > Design Mode. Click the pinboard 
name. WhizAI allows you to edit the name, as required. 
 

 

4. Update the pinboard name, as required, and click outside the textbox. WhizAI saves the updated 
pinboard name as shown in the following figure:  

 

 

Changing Visualization on Pinboards cards 

Follow the steps given below to change the visualization of your pinned cards on your pinboard without 

expanding the cards:  

1. Hover on the card and click the  icon at the bottom right corner of the card. This will display a list 

of visualization types such as ., Tabular, Pie, Treemap, Column, Pareto, Donut, Bar, etc.). 

 Note! For ipad users the icon is available by default. 
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2. Click the desired visualization type from the list.  

     

3. The collapsed card shows the newly selected visualization type. Click Save to keep the new 
visualization, or Reset to revert to the previous visualization. 
 

 

  
Note! Board owners or editors can Save or Reset the visualization changes. Board viewers can 
only make temporary changes. 
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Managing Pinboards with Design Mode  

 Note! This feature is only available for board owners and not for board viewers. 

 

You can format your pinboards using the new design mode option. You can change the layout for: 
• Pinboards and cards pinned to these boards. 
• Filters  
• Narratives on Pinboards  

Changing the layout for pinboards: 

1. Open the pinboard and click this  icon. 
 

 
 

2. Click Design Mode. The pinboard design mode is displayed. 

 

 
 

From the Pinboard Layout tab, you can change the: 

• Background color of the pinboard 
• Font Color 
• Font Size 
• Font style of the pinboard name 
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• Rename the title of the boards 
• Resize the pinboard grid layout 
• Format Card Layout 
• Format Filters layout 

Changing the Grid Layout for Pinboards 

You can create a granular and tailored grid design for pinboards ensuring consistency and control over the 

appearance of your data visualizations. As a pinboard designer you can change the Grid layout of 

pinboards using the following customizations options:  

 

 

Pinboard Grid Layout section offers the following customization options: 

● Number of Columns: Define the number of columns for the grid using a numeric textbox. Tooltip 

explains that increasing the value makes the pinboard more granular. 

○ Values: an integer from 1 to 2000 

○ Default: 20 

● Margin: Controls the space between cards in pixels via a numeric textbox.  

○ Values : an integer from -10 to 100 

○ Default: 20 

● Layout Type: Choose from: 

○ Fixed Aspect Ratio: Cards increase proportionally with screen size. 

○ Fixed Row Size: Cards maintain consistent height while adjusting width based on screen 

size. 

○ Single Page View: Eliminates scrollbars and resizes cards to fit the screen. 

● Aspect Ratio (For Fixed Aspect Ratio): Define the ratio of card height to width using a numeric 

textbox, allowing fractions.  

○ Values: a decimal from 0 to 100 
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○ Default: 1 

● Row Height (For Fixed Row Height): Specify the fixed height of rows in pixels using a numeric 

textbox.  

○ Values: an integer from 1 to 100 

○ Default: 20 

● Reset Option: A reset option allows users to revert to the last saved settings. 

Backward Compatibility 

 Note! Existing pinboards retain their current layouts unless the user makes changes to any of the 
new properties. Upon modifying and saving, the new grid properties are applied. 

Changing the Layout for cards: 

1. Open the pinboard and click this  icon. 
 

 
 

2. Click Design Mode. The pinboard design mode is displayed. 
 

 
 

3. From the bottom right side, click Card Layout. You can then change the layout for cards. 
 

 Note! On the top-right corner of every card, you can see a check box. When you select that 
checkbox, WhizAI displays options to edit the card on the right side. 
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From this tab, you can change:  
• Background color 
• Border color 
• Font color 
• Font size 
• Font style of the card 

 

You can also hide the title and the card context. After you finish changing the layout, you can click the Save 
button to save all the changes. 
 

 
 

Changing the Filters Layout: 

1. Open the pinboard and click this  icon. 
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2. Click Design Mode. The pinboard design mode displays.  
 

3. Click Filters Layout. You can edit the layout for filters. From this tab, you can change font, font color,      
and size of the filter title and filter values. 

 
 

 

 

‘Analytics’ tab in Pinboard Design mode 

While designing the layout for cards (for tabular or trend data) in a pinboard design mode, you can see a 
slider that contains two tabs:  
 

• Analytics: explore various data display options, apply conditional formatting to highlight important 
insights, and utilize comparison formatting to make meaningful comparisons between data points. 
Additionally, you can leverage spotlighting capabilities on tables and trend charts to draw attention 
to specific areas of interest. 
 

• Format: customize the appearance of your cards, that is, apply various formatting options, including 
changing the color of values, borders, and backgrounds. Additionally, you have the flexibility to 
adjust the style, font size, and color of titles and subtitles. A format tab is available for all the 
responses. 
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Accessing the ‘Analytics’ tab 

1. Open a pinboard and from the top-right corner of the window click the vertical ellipsis icon  > 
Design Mode. The Design Mode is displayed. 
 

2. From the right side, click Card Layout. WhizAI displays a checkbox on individual cards on the 
pinboard. 

3. Hover over the card you wish to format. WhizAI displays  icon on that card.  

4. Click the  icon on the card you want to format. It will expand to show you more details and 
options in the layout tab.  
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 Note! If you select multiple cards, the expand icon  is not available for those cards. 

 

5. After expanding the card, you will see an option to toggle between the Format and Analytics tabs. 
 

 
 

 Note! This toggle will only be available when you have selected a single card. If you select 
multiple cards, the toggle will not be displayed. 

6. From the Analytics tab you can change: 
 

o Data Display 
o Conditional Formatting 
o Comparison 
o Spotlight 

 

 Note! For more information on the options available on the Analytic tab refer to the section 
“The options available on the Analytics tab. 

Options available on the Analytics tab 

The Analytics tab displays different options for different types of responses. 
 

Analytics options for table response: 
• Data Display: You can use this option to choose how data is represented in the metric column. The 

data display style options are included. 
• Value (default) 
• Value With Indicator: If you choose Value with Indicator, a default triangle indicator is added 

before the data values. You can also choose a different indicator from the indicator 
dropdown and Placement value. 

• Value With Bars: Selecting Value with Bars displays bars in the metric column. 
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Example 1: Value With Indicator displays the indicator icon on the selected metric. 
 

 
 

Example 2: Value With Bar displays the bars on the selected metric. 
 

 
 

• Conditional Formatting: To add rules and colors to enhance data analysis. 
o You can select a metric and choose the formatting type: Rules or Gradient. The formatting 

will respect the data representation chosen for each metric (e.g., indicator or bars). 
o You can set rules based on operators and values and assign colors to reflect those rules. 
o When you switch toggles off, changes are temporarily turned off, and the response reverts to 

default values or representation. 
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Example 1, Conditional formatting with Gradient displays highest to lowest values in color gradients 
for the selected metric. The lowest value is indicated in red color and the highest in green color. 

 

 
 
Example 2 
 

 

  

In the above example, TRx data for Arobi/tier 1 is displayed in bars, and gradient conditional 
formatting is applied on it. 

 

• Comparison: To superimpose one metric on another (as data bars) for visual comparison. 
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o You can select primary and Comparison Metrics and choose how the comparison is 

displayed (bars or ticks). You can hide the Comparison Metric column using the table 
configurability dialogue. 

o You can select metrics from a list, and existing settings will be pre-populated.  
o When you switch toggles off, changes are temporarily turned off, and the response reverts to 

default values or representation. 
 

 Note! Please note that the Conditional Formatting and Comparison features are mutually exclusive. 
If one is turned on, the other will be turned off. 

 

Analytics options for trend response:  
• Enable Spotlighting helps you highlight specific data points on the chart. 

 

Accessing the ‘Format’ tab: 

1. Open a pinboard and from the top-right corner of the window click the vertical ellipsis icon  > 
Design Mode. The Design Mode is displayed. 
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2. From the right-side, click Card Layout. WhizAI displays a checkbox on individual cards on the 
pinboard. 

3. Hover over the card you wish to format. WhizAI displays  icon on that card.  

4. Click the  icon on the card you want to format. It will expand to show you more details and 
options in the layout tab.  
 

 
 



Understanding WhizAI User Interface 

 

 

198 of 315 

 
 
 
 

 Note! If you want to select multiple cards, close the expanded icon and select multiple cards.  

 Note! if you select multiple cards, the expand icon  is not available for those cards. 

 

 
5. Once you select a card and expand it, on the right side, you can see a slider that contains two tabs: 

Format and Analytics.  
 

 Note! These tabs are displayed under the Layout tab in Card Layout.  
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 Important! The Analytics tab is only visible for trend and table response. 

  

 
 

Using different options in the Format tab: 
 

The Format tab shows you all the common formatting options that are available for all cards. From the Card 
layout tab, you can format: 
 

o Title font, size, style, and color 
o Subtitle font, size, style, and color. 
o Border and background color of the card. 

 

 Note! The common formatting options are the ones you see when you select multiple cards 
together.  
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For specific visuals or legends, you can change the color of the metric time period, or dimensions which is 
reflected in the legend. Use the Values Color option to change the colors of the legends. 
 

You can change the value color in three ways: 
o Click the legend 

OR 
o Click the visual, such as a Trendline or Bar 

OR 
o Select the value from the drop-down label Values Color under the Format tab. 
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 Important! Any changes you make to the color of the metric or time period will be saved and 
maintained even when you perform other actions, apply filters, or export images as PDF or PPT files. 

Data Labels and Tooltip 

Using the pinboard design mode you can now customize and manage labels and tooltips of the data points 
on the cards. For a particular data point, you can set the tooltip or the label as: 

• Absolute 
• Percentage  
• Both 

 

 

 
 

 Note! The default label for Pie/Donut/Radial/100 stack/ 100 area chart etc. is always a percentage. 
Also, you can choose to enable a tooltip for your chart. Similarly, for Tooltip, you can choose between 
Absolute, Percentage, or Both. 

 

To manage the data labels and tooltip: 

1. Click the  expand option for the card (chart) you want to enable data labels. The card is opened 
in the Layout tab. 
 

2. Click the Analytics tab. 
 

3. The Data Labels and Tooltip are enabled as per your previous chart representations. Edit the Data 
Labels and Tooltip as required. 

 

4. Click Save. 
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 Note! Data labels are supported as per the visual chart space and pie charts.  

Creating Sections on Pinboards 

In pinboard design mode, board owners can logically group and organize all the cards in different ‘sections. 
Sections are components that can be dragged from the Object tab and dropped on the pinboard. Having 
these sections allows the board owners to apply section-level filters. Such section-level filters override the 
card-level filters.  However, if the section level filters are not present or the section filters are present but not 
locked, then the cards inside the section do get impacted by the global filters. 
 

 Note! Section-level filters have a locking mechanism that prevents these filters from getting 
overwritten by board (global) filters. 

 

 Note! Filters are applied in a specific order; pincards, sections, and then pinboards. The rank 
determines the priority unless filters are locked. 

 

This helps you update the filters of only the desired cards grouped in sections to ignore global filters, and 
those that are not grouped in sections read the global filters. 
 

Also, you can add annotations and titles to these grouped cards and format the sections by selecting the 
desired section and it will open in the Object tab. 
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To add a section to a pinboard: 

1. Open a pinboard. From the top-right corner of the board, click on the vertical ellipsis icon  > 
Design Mode. The Design Mode is displayed. 
 

2. Click the Object tab. You can see the Section icon. 
 

 
 

3. Click and hold the Section icon , and drag it to the pinboard to create a section as shown in the  
figure below. 

 

 
  

4. Add the Section title and Section description, as required. 
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To add and remove cards from the section 

1. From the top-right corner of the section, click the Add / Remove cards link. A new window opens 
which contains all the cards on the pinboard. 
 

 
 

2. Select the card(s) that you must add to the section.  
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3. Click Save. Selected cards are added to the section. 
 

 Note! To rearrange the cards, you can drag them along the canvas of the section and drop them at 
the desired location, as required. You can also resize the cards by dragging them by the edges or 
corners. 

 Note! Users will not be able to create sections on an empty pinboard if there are no cards available. 

 

 
 

 Note! To remove the card from the section, click the Add/Remove cards; clear the checkbox of the 
cards that you want to remove, and then click Save. 
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To resize a Section 

1. To resize a section dragging it by the edges or corner.  

 
  

Section Resizing and Layout Flexibility in Pinboard 

Section Resizing can be done in following ways: 

 

● Flexible Resizing: Pinboard sections can be adjusted horizontally and vertically, offering designers 

precise control over layout dimensions. 

● Custom Layouts: Designers can place multiple sections side-by-side or stack them, creating highly 

customizable layouts that fit their data display needs. 

● Independent Sizing: Each section size remains independent, ensuring no restrictions based on the 

presence of other sections nearby. 

● Backward Compatibility: All existing pinboards maintain their original layout and sizing, ensuring 

no disruption to previous configurations. 
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● Validation and Compatibility: Sections automatically prevent overlap with one another, ensuring a 

clean, organized appearance. The enhanced layout capabilities extend to exported pinboards, 

maintaining consistent output. 

 

Auto-positioning in design mode and expand-collapse in view mode 

Under Pinboards > Design Mode > Object in the Sections layout, WhizAI has now added an Auto-
Position toggle button at the top center of the screen. When you turn off Auto-Position, the cards 
are overlapped with subtle red borders (indicating they are overlapped) and then the cards can be 
moved easily, as shown in the figure below: 

 

When you turn on Auto-Position, and then try to move the cards, they can be reordered, as shown 
in the figure below: 
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 Note! Auto-position is available in design mode only. 

 

 Tip! You can now auto-scroll, while dragging the card or section. You can expand-
collapse your cards in ‘View’ mode using the small down arrow key at the top-left corner of each 
section, as shown in the figure below: 

 

Best practices:  

1. Turn the default Auto positioning to ON. 
2. Firstly, create blank sections in boards anywhere in the pinboard.  
3. With auto-positioning ON, add cards in the respective sections (to avoid overlapping issues with 

cards that are outside of the section) 
4. Turn the Auto-positioning OFF and now rearrange the sections appropriately.  

To delete a section 

1. Click the ellipsis icon  and click Delete.  WhizAI confirms whether you want to proceed with the 
action. 



Understanding WhizAI User Interface 

 

 

209 of 315 

 
 

2. Click Delete. 
 

 Note! If you delete the section, the cards in the section are moved at the end of the pinboard 
without disturbing the board layout. 

 

 Note! You can select multiple sections by selecting the check boxes, and format (customize) 
them at the same time. 

 

 

To Navigate directly to the section using a URL 

You can navigate directly to any section by copying and pasting its URL into your browser. This allows you 
to share links or bookmark them that provide direct access to specific sections. By bookmarking the section 
links, you can easily navigate across multiple sections and pinboards. 
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To  copy a  section  url: 

1. Hover on the Ellipsis icon  at the top right side of the section, click Copy Section Url. The url 

section is copied.  

 

2. Paste the copied url to your browser and bookmark it for future reference. Write the name of the 

bookmark and click Save. 
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Object Formatting 

You can format your sections using the design mode option. You can change the layout for Sections Using 
the Object > Object Formatting: 
 

From the Object Formatting tab, you can change the: 

• Background color of the section 
• Section Border 
• Section Fonts 

o Font Size 
o Font style  

• Rename the section boards 
• Resize the Section Grid Layout 
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Changing the Section Grid Layout for Pinboards 

 
Section Grid Layout offers the following customization options: 

● Customize Grid Layout Toggle: By default, sections inherit pinboard-level grid settings. When 

toggled ON, it enables customized layout settings for a section. 

● Number of Columns: Define the number of columns for the grid using a numeric textbox. Tooltip 

explains that increasing the value makes the pinboard more granular. 

○ Values: an integer from 1 to 2000 

○ Default: 20 

● Margin: Controls the space between cards in pixels via a numeric textbox.  

○ Values : an integer from -10 to 100 

○ Default: 20 

● Layout Type: Choose from: 

○ Fixed Aspect Ratio: Cards increase proportionally with screen size. 

○ Fixed Row Size: Cards maintain consistent height while adjusting width based on screen 

size. 

○ Single Page View: Eliminates scrollbars and resizes cards to fit the screen. 

● Aspect Ratio (For Fixed Aspect Ratio): Define the ratio of card height to width using a numeric 

textbox, allowing fractions.  

○ Values: a decimal from 0 to 100 

○ Default: 1 

● Row Height (For Fixed Row Height): Specify the fixed height of rows in pixels using a numeric 

textbox.  

○ Values: an integer from 1 to 100 

○ Default: 20 

● Reset Option: A reset option allows users to revert to the last saved settings. 
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Backward Compatibility 

 Note! Existing pinboards retain their current layouts unless the user makes changes to any of the 
new properties. Upon modifying and saving, the new grid properties are applied. 

Object Visibility 

Conditional Hide/Show for Sections in Pinboards 

In the pinboard Design Mode > Object tab > Object Visibility section, the Default State allows you to 
Show or Hide a particular section on a pinboard when the enabled conditions match pinboard filter values. 
 

 
 

The Object Visibility contains the following options: 
 

• Default View: You can define whether you want to Show or Hide the section.  
When the default state is Show, then WhizAI displays Enable Conditional Hide toggle.  
If you set the default state as Hide, then WhizAI displays the Enable Conditional Show toggle.  

 

• Enable Conditional Hide: Enable this toggle and add conditions. If these conditions are 
satisfied at a dashboard, WhizAI hides the section.  

 

• Enable Conditional Show: Enable this toggle and add conditions. If these conditions are 
satisfied on a pinboard, then WhizAI displays the section.  

 

• + Add Condition: This condition has three parameters, viz Dimensions in the data model, the 
Operators (In and Not In), and the Values of the dimension. Considering the default state as 
Show, Enable Conditional Hide is satisfied when: 
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o Dimension In/ Not In section value matches the pinboard filter. 
 

Or 
 

o Dimension In/ Not In section value matches the slicer. 
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Or 
 

o Dimension In/ Not In section value matches default filter value. 
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 Tip! If In operator hides the section for a certain dimension value then it will show the section 
for the Not In operator for the same dimension value 

 

 Note! You can see the Section Layout section when one or more section/s exist on the 
board. 

 

 Note! You will always see the section by default. 

 

Note: You must define the conditions based on the following set of rules: 
• Select one or multiple conditions to set the show/hide state. 
• As per multiple conditions only the AND operator is applied. 
• You can select multiple sections and apply common rules. 
• When there are conflicting conditions in multiple selected sections, the conditions are reset when 

you try to make some changes to the section layout. 
• When you select the individual section, the common rules are displayed, and you can add more 

conditions to it.   
• If conditions on individual sections are applied and now if you multi-select the sections, the previous 

rules are overridden. 
 

 Note! User authorization is considered when you apply dimensional filter values for the conditional 
drop-downs. 
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Hiding Section on Pinboard 

You can hide pinboard sections as board owners: 
1. Select the section you want to hide. Go to Object tab > Object formatting > Section Layout 

 

2. The Default State is Show. WhizAI Hides the section when the condition is enabled. 
 

3. Click the Enable Conditional Hide toggle. The + Add Conditions button becomes available. 
 

4. Click +Add Conditions. The options to define the conditions to hide the section are displayed. 
Refer to defining sections to understand how to set the conditions. 

 

5. Select the Dimension as Region, Operator as In, and Values as Mid-Atlantic for the 1st condition.  
 

 
 

6. Select Save. The Recent Pinboard is displayed. 
 

7. Add Filters (+) as Region. Choose Mid-Atlantic from the drop-down. 
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8. Select Apply. The Section gets hidden when the condition is satisfied with the pinboard filter. 
 

 
 

9. Click Save Changes. 

Setting Default section view as expanded or collapsed 

In the pinboard Design Mode > Object tab > Object Visibility section, the Default View toggle allows 

you to set your default preference to Expand or Collapse sections on pinboards. 

 Note! Regardless of the preferences set by the pinboard owner, the section will always be in Expand 
mode for the shared viewer. 

 

• Default View: This toggle allows the board owners to set their default  preferences as expand or 

collapse for each section. Viewers can easily expand or collapse the section the pinboard via . 

• Expand: Enable this toggle and click Save, WhizAI sets the default view of the section on the 
pinboard in the Expand mode.  

• Collapse: Enable this toggle and click Save, WhizAI collapses the section on the pinboard. 
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Hide/Show filters for Sections in Pinboard 

In the pinboard Design Mode > Object tab > Object Visibility section, the Option to Manage Filter 
allows you to Show or Hide the Show Filters link on a pinboard section. 
 

The Option to Manage Filter contains the following options: 
 
 

• Enable Hide: Enable this toggle, WhizAI hides the Show Filters link for the selected section.  
 

• Enable Show: Enable this toggle, WhizAI displays Show Filters link for the selected section.  
 

.  
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Managing Pinboards from Pinboards Manager 

 Note! Pinboards manager is a configurable feature. In case, it is not configured for you, you see the 
main pinboards page. 

From the pinboards manager page, you can view pinboards organized in different categories. 

• Favorites 
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• Recent 

• My Pinboards  
• Shared  
• All Pinboards 

 

This categorization of the pinboards helps you manage the boards and easily navigate to the boards, as 

required. When you click All Pinboards on the Explorer, you will be redirected to the Pinboard Manager 

page. By default, the Recent section opens as shown in the following figure. 
 

 
 

From the left-hand side of the Pinboard Manager page, you can see various categories. You can group the 

boards in these categories for easy access. 

• Favorites: lists the pinboards that are starred in the Pinboard Manager section 

• Recent: displays the pinboards that you have recently visited and created 

• My Pinboards: create pinboards and import the pinboard as required. 

• Shared: shows the pinboards that are shared by other board users 

• All Pinboards: displays the list of all pinboards 

Adding ‘Labels’ to Pinboards 

1. Go to the pinboard and click the  icon. The pinboard information dialog is displayed. 
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2. Click + Add Label, enter a name for the label in the input field, and press enter. The label is created 
under Pinboard Navigator > Labels. 
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Adding Filters to Cards and Pinboards 

 Remember! WhizAI allows you to apply filters, view the updated data, and reset the board back to 
its original state, if required.  

After you (as a board owner or editor) apply filters or slicers to pinboards, you can view the updated data on 

cards, and later revert the changes so that there is no change in data for the users with whom the board was 

shared.  

 Remember! When you (as a board owner or editor) ‘apply’ filters, the data is updated only for you.  

After you ‘apply’ filters, you see the following two buttons on the UI:  

• Save Changes: If you click this button, WhizAI updates the data for all the users with whom the 

board is shared. 

• Reset Changes: If you click this button, WhizAI reverts to the original state of the board. 

While applying filters to pinboards, the values you see in the dimension filters depend upon the value 

selected in the Metrics filter, as shown in the following figure:  
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When the selected metric value is changed, the corresponding values in Dimension filters also change. The 

values that are no longer applicable get greyed out. To reset this metric-dimension filter relationship, click 

 and then click Reset Cascade. 

 Remember! The values set in filters on a pinboard affect the values in the cards pinned to that 
board. For example, if you select a particular metric from the Metrics filter on Pinboard, and a dimension 
filter on one of the cards. In this case, the dimension filter shows values according to the metric selected in 
the Metrics filter on the pinboard.  

 

 Note! When you apply filters to cards, you can see ‘Computations’ as an option to filter the data on 
cards. The values you see in the ‘Computation’ filter depend on whether this filter is applied 
independently or in combination with another filter. 

 

When you apply filters to cards, the existing filters are retained, and the newly added filters are highlighted. 

For example, if you ask WhizAI the following question “Show me the top growing accounts”. WhizAI displays 

the response as shown in the following figure: 
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As you can see in the above figure, no filters are added. Now, if you add the ‘Region’ and ‘Product’ filter to 

the card, then WhizAI filters and shows the corresponding data. The context shows the original metrics and 

the new filters are highlighted as shown in the following figure: 
 

 
 

To highlight the applied filer values, expand each card, go to  icon and switch on enable spot lighting 

toggle and click Save. 

The filter values get highlighted as shown below. 
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 Remember! While applying filters to pinboards, the system displays the filter values according to 
the authorizations set for a particular user, thereby allowing the user to query relevant data, only. These are 
data-driven dimensional filters and help a user narrow down the search. After you apply cascaded filters, 
WhizAI validates the user's authorization and displays corresponding data in the cards. 

 

In the ‘Period’ filter, you can see a date input field where you can select the date range using Gregorian 

calendar date picker. 

The date range entered (YYYY-MM-DD - YYYY-MM-DD) is displayed in the manual input field and includes 

validation to ensure that the "From" date is less than the "To" date. If the date range is truncated, it is  fully 

displayed on hover as a tooltip. 
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 Tip! On applying this date range on a pinboard or a card, it is displayed in the card’s context. 

 

 Tip! If the ‘Period’ filter is applied on a card, WhizAI allows you to lock the filter, that is, you can lock 
the date range entered in the filter. 

 

In the ‘Period’ filters on Pinboard there are various time buckets such as Month to Date (MTD), Current 

Month, Previous Month, Last ‘x’ months. Also, for ‘Quarter’ there are time buckets such as Quarter to Date 

(QTD), Current Quarter, etc. You can find similar time buckets for ‘Year’ as well.  

 

 Note! When you add a Period filter in WhizAI, you have the option to filter data by weeks, months, 
quarters, and years. For each of these options, you can select relative dates. For example, to filter data 
on Week basis: you can input the data for the current week, the previous week, or last ‘n’ weeks 
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with  ‘+’, and ‘-‘ buttons. Also, the custom date is configurable. You can show or hide the custom date 
range from the Admin > Content Manager >; Configurations > Period time buckets >; date range. 

 

 Remember! If required, Administrator users can configure WhizAI to make any of the above-
mentioned time buckets unavailable. Thus, these filter values do not get displayed in the ‘Period’ filter. 

If pinboards contain cards that show data for a fixed time period and if you set filters to view data for a 

period that is outside this range, WhizAI shows a message that highlights the time-period of the data shown 

in the card.  
 

For example, if a card always shows data only until 13 weeks and you apply filters to view data for period 

greater than 13 weeks, say 18 weeks. In this case, although the selected period is 18 weeks, WhizAI 

continues to show data for 13 weeks only. This can lead to confusion and to avoid it, WhizAI specifically 

shows a warning message that highlights the time-period of the data; thus, you get a clear idea about the 

date range for which the data is being displayed in the card. 
 

In the ‘Period’ filters on Pinboard there are various time buckets such as Month to Date (MTD), Current 

Month, Previous Month, Last ‘x’ months. Also, for ‘Quarter’ there are time buckets such as Quarter to Date 

(QTD), Current Quarter, etc. You can find similar time buckets for ‘Year’ as well.  

 Remember! If required, Administrator users can configure WhizAI to make any of the above-
mentioned time buckets unavailable. Thus, these filter values do not get displayed in the ‘Period’ filter. For 
more information on the different configuration options, check the configurations section in WhizAI 
Administrator’s Guide. 

 

When you add dimensional filters to pinboards, you can click the Select all check box to select all the filter 

options together (refer to the figure below). Thus, instead of selecting individual options from a very long list, 

now, you can click just one check box. 
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For example, if you add a region, District, or Territory filter to a pinboard, you can click the Select all check 

box to select all the regions, districts, and territories included in the filter list. 
 

 
 

If you want to select all the districts and territories only for a specific Region level.  

1. Click on the navigation bar of that Region and hover the mouse over this   icon, you can see the 
Select all check box as shown in the following figure. 

 

 
 

If you want to select all the territories only for a specific District level.  

1. Click on the navigation bar of that District and hover the mouse over this   icon, you can see the 
Select all check box as shown in the following figure. 
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 Important! The Select all check box can be seen only if the Multiple values option is enabled for a 
filter. Refer the product user manual for details on how to enable the multi-select option. 

 

 
 

 Note! This checkbox is enabled only for those dimensional filters that have values less than or equal 
to 10K. For values more than 10K, the following error message is displayed: “To enable this option, 
please refine search results by adding a filter before the current one” Please refine the search criteria”.  

 

Similar to pinboards, you can click the select all checkbox in a tabular response to select all the metrics and 
dimension columns. From the Columns dropdown list, you can click the Select all checkbox to select all the 
options. 
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To add filters to cards:  

1. Open the card from pinboard and then click Show Filters. 

 
 

 

2. After a card is pinned to a board, by default, the card has no filters. To add filters, click . WhizAI 

shows the Add Filters dialog. 
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3. You can search for the dimension or select the dimension from the list and then click Save to add 

the filter to the card. 

To add filters to Pinboards: 

1. Open the pinboard and then click  to add filters to the pinboard. WhizAI shows the Add 

Filters dialog.  
 

 Note! While applying filters to pinboards, the system displays the filter values according to the 
authorizations set for a particular user, thereby allowing the user to query relevant data, only. These are 
data-driven dimensional filters and help a user narrow down the search. After you apply cascaded filters, 
WhizAI validates the user's authorization and displays corresponding data in the cards. 
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2. You can search for the dimension or select the dimension from the list and then click Save to add 

the filter to the pinboard. 

 Note! User authorization is considered when you apply filters to pinboards, cards, and sections. 

 

 Note! For more information refer to the Admin manual  

Infinite scroll option for filters using lazy loading 

Using lazy loading the filter displays the first N number of records in ascending order where N is 

configurable in the dropdown with an infinite scroll option.  

 

For example, Add the filter Customer and click the drop downtown as shown below: 
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The dimension value dropdown displays the members with an infinite scroll option to improve 

performance. You can also directly search a specific value from the entire data set using the search bar for 

quicker access. 

 

 Note! The maximum number of values to be fetched for selection in a dropdown is a model level 
configuration named Initial Filter Item Count set through the admin panel 

Selecting first <no. of records> entries 

Here's how the ‘Multiselect filter limit’ behaves based on various data loading, no. of records, and filtering 

conditions: 

If 5000 records are loaded, but the Multiselect filter limit is 2000: 

• The checkbox is enabled, and labeled as “Select first 2000 entries”. 

• When clicked, it selects only the first 2000 entries out of the 5000 loaded records. 

If 5000 records are loaded and the Multiselect filter limit is greater than or equal to 5000: 

• The checkbox is enabled with the label “Select first 5000 entries”. 

• Clicking it, selects all 5000 records. 

If the page size is 5000, but only 750 records are available: 

• The checkbox is enabled, and the label says “Select all 750 entries”. 

• Clicking the checkbox selects all available entries. 

If the number of records exceeds the multiselect filter limit in any scenario: 

• The label always reflects the maximum selectable limit, e.g., “Select first <max. select all limit> 

entries”. 

• Clicking this selects only the defined maximum number of records. 

Tip! Keep ‘Multiselect filter limit’ value equal to or lower than the 'Initial Filter Item Count' value. 
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Smart board filters 

Using the ‘Show More’ button  and ‘Show Less’ button  against the filters on a pinboard you can 
expand or collapse the filters applied to the pinboards. As the filters can collapse, you get more space on 
the pinboards to add additional pinboard filters and explore different insights from the data. 
 

 
 

In the expanded mode, you can click the ‘Show Less’  button to declutter the filters. 
 

 
 

In the ‘collapsed’ mode, WhizAI displays the following types of filters, always: 
• Filters that are tagged as ‘Mandatory’ 
• Filters with values selected in them and applied  
• Filters that are tagged as ‘Pin’ 

 

When you apply a slicer or when you select a value in an empty filter to the board, the applicable hidden 
filters that are empty (values not selected in them) are moved to the visible filter area once you click Apply. 
 

Configuring Pinboard Filters 

1. Hover the cursor over the filter, the values of which you want to configure, and then. WhizAI shows 

the Configure Filter icon.  

 
 

2. Click the Configure filter icon. WhizAI opens the Filter settings dialog. By default, the Select All 

check-box is selected. Clear this checkbox. 
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3. From the list of available filter values, select the value, as required, and then click Apply. WhizAI 

populates the values in the drop-down list. 

 Tip! If you select Restore defaults, WhizAI overrides your selections and returns to the default 
settings. 

 

Configuring Mandatory Pinboard Filters  

You can configure Pinboard filters and set them as 'Mandatory'. To configure a filter as 'Mandatory', click 

the settings icon to open the Filter Settings dialog.  
 

At the bottom of this dialog, select the Mandatory checkbox as shown in the following figure and then click 

Apply. 
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 Remember! After a filter is configured as 'Mandatory', it is required to have some value selected in 
the filters. Mandatory filters cannot be empty. The button to apply the filters on pinboards is available only if 
the Mandatory filters contain values, as shown in the following figure: 

 
 

 

Configuring filters to have multiple values 

You can configure a pinboard filter or card filter so that multiple values can be selected, and the filter can 

be applied.  

To complete this configuration: Hover the cursor on the filter and click the settings icon to open the Filter 

settings dialog. Select the values to be displayed in the filter and from the bottom, click Multiple values as 

shown in the following figure: 
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After this configuration, WhizAI shows a checkbox against each filter value. You can select either one or 

multiple filter values and click Apply to filter the data.  

 
 

When data is filtered by applying multiple filter values, we would like to point out how some of the other 

features would behave:   
 

• Slicers: When a filter is configured to allow the selection of multiple values, the slicer also allows 

multiple values to be selected for that filter. 
 

• Annotations: You can add notes to cards that include multiple values (for example: two values) in 

the context. To view the notes, the card must have all the values in the context. If the context is 

changed to include only one of the values, WhizAI does not show the added notes.   
 

• Authorization:  Even if the filters contain multiple values, you shall be able to see only the data for 

which you are authorized.   
 

• Locked Filters: If you select multiple values in a filter and then lock it, the values cannot be 

overridden by pinboard-level filters or card-level slicers. 
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• Hierarchy Filters: You can select multiple values that belong to the same hierarchy level, only.  

According to the first value selected in the filter, WhizAI allows you to select the corresponding filter 

values of the same hierarchy level. Remember! In case you add multiple values falling under the 

same hierarchy, the card displays data for the lowest hierarchy entity.  
 

• Cascaded Filters: The values in the corresponding cascaded filters depend upon the selection you 

make in the first filter. For example: If you configure the Region filter for multiple value selection and 

select Mid-West and North-East regions, then the District filter shows values for Mid-West and 

North-East regions, only. 

Applying Filters to All Pinboards 

WhizAI allows you to set filters for one pinboard and apply the same context to all pinboards. By this action, 

the same set of filter values is applied to all pinboards (owned and shared). 
 

For example, for Mypinboard, you can add a new filter, Regions, and select Midwest. Click on Apply to 

all boards.  

 
 

Click on Save Changes. 
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All pinboards with Regions as a filter will be automatically filtered on Midwest. For example, see below My 

Product Dashboard pinboard.  
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Locking Filters in Cards 

1. Open the card from the pinboard and click Show Filters to view the filters on the cards.  
 

2. Click  to add filters. WhizAI shows the Add Filters dialog. 

3. Add the filters to cards and then click Lock icon as shown in the following figure: 
 

 
 

The filter is added to the card. Note that this filter has a lock symbol next to it.  

 Tip! To unlock this filter, you can click the lock icon and then click ‘Apply’. 

 

 Note! Now, if the same filter is added (at board level) but with a different value, WhizAI will not 
override the data for this card; it retains this filter and applies the additional filter to other cards. 

 

 Tip! The lock symbol means that the value you select in this filter is locked. After locking the filter 
value, if the same board-level filter is added but has a different value, WhizAI does not override this 
card-level filter; it retains this filter and applies the additional filter to other cards. 

Actions supported on card/s in collapse mode 

WhizAI supports some of the common actions on card/s in Collapse mode for all the tables and charts. To 

perform these actions, you are not required to expand the card/s. You can perform the below actions in the 

collapsed mode: 



Understanding WhizAI User Interface 

 

 

243 of 315 

• Reorder the column/s: drag and drop the columns to manually reorder. 

• Pin Column/s: lock column/s to the left side so that when you scroll either to the left or right, the 

pinned column/s remains at the same location. 

• Pagination: scroll through the response all the way to the last row irrespective of the number of 

records in the response. 

• Roll Up/Drill Down: roll up or drill down through the response details to get more information. 

• Expand All and Collapse All: expand or collapse the data in the nested tables. 

Adding Cascading Filters to Pinboards 

1. Open the pinboards and click to add filters to the pinboard.  
 

2. From the filters, apply the filter, as required. For example, you apply the ‘Location’ filter and select 
‘Mid-West’ value. 
 

3. Again, click  to apply a second filter. If you open the drop-down list for this filter, you can see 
that WhizAI displays the values in the second filter depending upon the value you have selected in 
the previous filter. For example, you select ‘Location by regions’ filter and select ‘District’ value 
Thus, as you have selected Mid-West as the Region in the previous filter, now, WhizAI shows all the 
Districts under Mid-West region.  
 

4. Select any district, as required, and click Apply to filter the data.  

Adding Hierarchy Pinboard Filters 

You can apply ‘Hierarchy’ filters not only to pinboards but also to the cards within pinboards. If the same 

filter (for example: Location filter) is applied to cards and pinboards, the filter applied last is used to update 

the data.  
 

Thus, if you apply filter on boards, first, and then apply filter on cards, the value in card filter is used to 

update the data or if you apply filter on boards (after applying filter on cards), the data is filtered according 

to the value in board filter.  
 

In case there are different filters on cards and boards, for example, the board contains a hierarchical filter, 

and the card contains a dimensional filter or vice-e-versa, in this case, the system understands the difference 

between hierarchical filters and dimensional filters and shows the correct data without any conflict.  
 

For example: If a card contains a simple dimensional filter (Region, District, and Territory), and a hierarchical 

filter is applied to the pinboard (Location: South), the card’s dimensional filters are updated accordingly: 

District and Territory are reset, and the result contains data for ‘South’ (because it was the latest applied 

value). 
 

In case a card has a ‘location’ filter applied to its data and then multiple dimensional filters are applied to 

the board (for example: ‘Region: South’ and ‘Territory: Boston MA’) in this case, the system updates the data 

on the card to reflect the narrowest applied filter value which in this case is: Territory ‘Boston MA’. Thereby, 

the location filter in the card shows the updated value as ‘Boston MA’.  
 

To apply hierarchy filters: 
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1. Open the pinboard and click  icon to add filters. WhizAI shows the Add Filters dialog.  
 

 
 

 Note! Under Dimensions, you can see the Locations by regions filter. This filter has a 
hierarchy tree. You may click the arrow to view the values in the hierarchy tree.  

 

2. Under Dimensions, select the entire filter as shown in the figure. 
 

3. Click Save. The Location by Regions filter is added to the pinboard. If you open this filter drop-

down list, you can see a hierarchy of filter values. 
 

 

Auto-expansion of rows for Hierarchy filters 

Earlier, after you applied a filter of lower hierarchy dimension to your card, the sub-categories or sub-levels 
of data were not visible. Now, we support auto-expansion of rows with hierarchy filters, in design mode with 
spotlight feature enabled. The expanded rows are highlighted, and the relevant subcategories or sub-levels 
can be seen. 
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 Note! After the hierarchy filters are applied, you can directly view the highlighted and automatically 
expanded rows, only If the Enable Spotlighting feature is already enabled. 

 

Example query: ‘Show Region by District by Territory’ 
 

 
 

1. Add the following filters: 
o Territory: Boston South 
o District: Boston  
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2. Click Apply. 
  
 

 
‘ 
 

3. You see the filter is applied to regions, and when you expand the drop-down you can drill down the 
lower hierarchy dimension filters such as District and Territory. 
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4. Go to the hamburger icon  from the top-right corner of the window and click Enable 
Spotlighting. 

 
  

5. The filtered lower dimensions such as District and Territory are dynamically expanded and 
highlighted as shown in the figure below. 
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 Tip! If you want to disable the spotlight feature, go to Admin > Content Manager > 
Configurations. From the drop-down list click Field Analytics. Set Enable Row Highlighting to false. 

 

 Note! If multiple territories are selected in the filter, then the alphabetically first filter will be 
expanded and highlighted, and other territories will only be highlighted. 

 

 Note! Even when the table and hierarchy data are loaded lazily (i.e., progressively as needed), the 
totals will always be displayed upfront. These totals represent the aggregate values of all hierarchies in 
the data, regardless of lazy loading. 

 

 Note! The XLS/CSV files retain the format of the response while exporting. 

Performance enhancement - Lazy loading 

As a part of the performance, lazy loading optimizes your pinboard and nested hierarchy pinboard. 
On a pinboard with multiple cards, only the cards within your viewport are fetched and loaded. As you 
scroll down, and start seeing more cards, the data dynamically loads in tandem with your view. Thus, you do 
not load the data for the pinboard in one go. 
For nested hierarchy cards, we fetch the data on demand, that is when you expand the hierarchy, we 
expand only the 1st node through the entire hierarchy. When you click on expand all, 1st node is expanded 
to the last unit until its hierarchy. 
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Adding Computation Filters to Pinboards 

WhizAI allows you to filter data on all the cards in a pinboard by applying computation filters. You can apply 

the contribution filter to view the average metric values, the contribution, the growth values, or the market 

share.  

1. Open the pinboard and click  icon to add filters. WhizAI shows the Add Filters dialog. 
 

 
 

2. Select Computations and then click Save. The Computations filter is added to the pinboard as 
shown in the following figure: 
 

3. Select a computation filter value, as required, and then click Apply. WhizAI filters the data on all the 
cards in the pinboard according to the selected filter value. 
 

 Note! After WhizAI filters the data based on computation values, the card context shows the 
corresponding computation value. For example, if you apply the ‘Average’ filter the card context shows 
‘Average TRx volume’.  

Spotlighting of Parent Nodes in the Absence of Data for Filtered Dimensions 

When there is no data in the filtered dimension of the column, its parent nodes get highlighted when the 
spotlight feature is enabled. 
 

Example query: “Trx by region, territory” 
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To enable the spotlighting: 
1. Pin the response Trx by region by district by territory. 
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2. Apply the following filters: 
Period: 2 weeks 
Product: Plabenil 
Territory: Charleston 
 

 
 

3. Click Apply. The filtered list is displayed. 
 

 
 

4. Go to the hamburger icon and click Enable Spotlighting. 
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5. In the given scenario, the Territory Charleston, which falls under the District Charleston, does not 

have any data specifically related to the Product Plabenil. Due to this absence of data, when looking 

at the table (shown below), you will not see Territory Charleston listed. However, if you apply a filter 

to specifically display data for Territory Charleston and have spotlighting enabled, the highlighting 

feature will still highlight the upper hierarchical parent, which in this case is District Charleston. This 

is because spotlighting aims to visually indicate the hierarchy and relationships between different 

levels of data. However, since there is no data available for the selected filter of Territory Charleston, 

it will not be displayed in the table. 
 

 
 

Query for reference: “by territory name by products for district Charleston for last two weeks” 
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Applying Common Filters across Multiple Pinboards 

WhizAI gives you the ability to create a set of filters and apply the common filters from this set across 

multiple pinboards. Thus, you don’t have to spend time selecting the same filters, again.  

Remember! The filters are passed to the other pinboards only when you click ‘Apply’. Also, only common 

filters are passed to other board/s. The new filters will override the user defaults. If you change the data 

model, the selected filters do not get passed to other board/s.  As a board ‘owner’, if you apply the filters to 

all the pinboards, although the filters get passed to all the other boards, you must go to each board and 

‘save’ the changes.  

If you are a ‘Viewer’ of a board, you cannot save the changes. The filters are reset after you refresh the page.  

When applying such common filters, note the following points and how the filters behave under these 

scenarios:  
 

• Hierarchy Filter vs Single Dimension Filter: 
On Board 1 if you have hierarchical filters → Region, District, Territory. From this filter, you choose 
‘D1’ as a district and click Apply Globally. 
On Board 2 you have only a single dimension ‘District’ filter. In this case, the district value ‘D1’ is 
passed on to Board 2.  
 

• Cascading Filters: 
On board B1 if you have selected the market filter with value ‘M1’ and then you ‘Apply’ the changes. 
On board B2 if you have market ‘All’ and product filter ‘P1’, in this case on board B2, the ‘Product’ 
gets reset if it is conflicting and the market ‘M1’ value gets passed on to Market ‘All’. 

 

Also, WhizAI can show multiple default values on pinboards, therefore multiple values can be selected in 

user default for the dimensions. 
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Changing Values of Applied Filters  

1. Open the pinboard, as required, and click the filter, for which you must change the value. WhizAI 

opens the drop-down list.  
 

2. From this drop-down list, select the filter value, as required, and then click Apply. WhizAI filters 

details on all the cards. 
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To change the filter values on an individual card 
 

1. Go to the pinboard, as required, open the card, and then click the filter, for which you have to 

change the value. WhizAI opens the drop-down list.  

 
 

2. Select the filter value, as required, and then click Apply to filter the details on the card. 
 

 
 

Drag and drop filters on pinboards 

You can drag and drop the filters on pinboards to reorder them. For example, let’s say you add Region, 

Geography, and Products as filters on a pinboard. You can simply drag and drop these filters to reorder 

them, as shown in the following figure: 
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Filtering behavior for pinboards 

After you add and apply filters to pinboards, the cards show only the particular record that you searched. 

For example, if the Region > Mid Atlantic filter is added and applied as shown in the following figure:  
 

 
 

The card displays the data only for Mid-Atlantic region as shown in the following figure. 
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 Note! If you want to view all the rows (and not just the filtered row), you can click the Enable 
Spotlighting toggle button. This shows all the records in the table and highlights the filtered record. 
Row highlighting can also be enabled from configurations on UI. Contact your system administrator for 
more information. 

Hierarchical charts in compact mode on Pinboards 

The hierarchical chart displays metric data upfront for a single metric in compact mode. For multiple metric 
horizontal or vertical hierarchy charts, data is only displayed when you hover the mouse on the metric 
values. 
This ensures a more user-friendly experience, making valuable information immediately accessible without 
the need to expand the card. 
 

 Note! In a compact mode in Pinboards the dimension name is displayed only on the first node. 
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Column Reordering in Charts and Pinboards  

As an owner or admin, you can drag-and-drop the column to re-order the default column arrangements in 

charts and pinboards. 

This feature ensures that changes made to one column are automatically applied to all the repeated 

columns.  
 

 
 

Suggested methods for column reordering in crosstab response to retain custom order  

 

1. First, save the custom order changes made to the parent column, then proceed to modify the child 

columns and save the changes again. 

2. Reorder columns in a table with multiple pivots and repetitive columns only when all pivots at every 

level are present in the response. 

3. It is  recommended to make selections or deselects one at a time simultaneously to  both the parent 
(Product) and child (Metric) columns from the table configurability box and then Save the card. 
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Example 1: Pin response for “TRx average, TRx volume, TRx growth by regions by products“  
 

• Move Growth Trx to first position and Emarun in place of Arobi and click Save. 

 

• 1a. Suggested method of using this feature: 

From the table configurability box Uncheck Growth TRx only and click Apply. Average TRx and 
TRx Volume  columns retain their reordered position. 
 

• To reintroduce the Growth TRx column to the response check the Growth Trx option from the table 
configurability.The column is added back to the response, retaining its position as the first column in 
the custom order. 
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• 1b. From the table configurability box Uncheck Arobi only and click Apply. Other columns retain 
their reordered position. 

• To reintroduce the Arobi column to the response check the Arobi option from the table 
configurability.The column is added back to the response, retaining its position as the 2nd column in 
the custom order. 

 

 

Saving the resized column size on the pinboard 

As an owner or admin, you can resize columns on cards, adjusting them according to the length of any 

dimension or metrics. Once the card is saved, the modifications are visible to all viewers using the same 

board. This saves time from manual resizing of the columns every time the card is expanded and collapsed. 
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 Note! The option to save the card whenever it is resized is available both in expanded and collapsed 
mode. 

 

 Tip! When the hidden column is added back to the response through the configurability table, the 
column retains the last saved column width. 

Configuring display formats of metrics for table responses 

WhizAI provides the ability to select a configuration to display full numbers on tables. This allows you to 

view the numbers without shortening them across the model . 

Go to Admin > Content Manager >  Configurations > Global > Table Metric formatting threshold to 

define the default value. All the numbers lower than the set value are displayed in full format. For example, 

The threshold value is set as 999 as shown in the figure below.. 
 

 
 

All numbers lower than 999 are displayed as full numbers. 

Example query: Show me top territory by TRx. 
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 Note! The number formatting displayed in tables and charts are consistent with the exported 
XLS/CSV file format.  

 

 Note! The time period ‘quarter’ displayed as Q1 and Q2 and time period ‘semester’ displayed as H1 
and H2 in tables and charts are consistent with the exported XLS file format.  

Saving the sorting order on cards in pinboards 

 Note! This feature is only available for board owners and not for board viewers. 

On cards in pinboards, when you sort the columns, you can save that sorting order. For example, if you ask 
the query ‘Show me TRx by region’ you will get a response as shown in the following figure. 
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When you sort the column TRx and save the changes, the sorted order gets saved as shown in the following 
figure: 
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No Default sorting icon on top_N Trend, and crosstab queries 

You do not see the default sort icon  for tables in responses to the following queries: 

• Top_N trend query - ‘Show me top 50 customer by week’ 
• Queries with two dimensions; the first dimension is asked with a certain threshold - ‘top 10 

customers by brands.’ 

 

Trend tables often display aggregated values over a period of time, such as monthly sales totals. These 

aggregated values are calculated based on the underlying data, but they may not be explicitly included as a 

column in the table. 
 

The default sorting symbol typically denotes the sorting order of a specific column in the table. However, 

since the aggregated value column is not directly present in the response table, WhizAI does not provide a 

default sorting symbol. 

 Tip! The absence of a default sorting symbol reflects that the response contains aggregated data 
and the focus is on temporal analysis rather than specific column sorting. 

 

Example Query: ‘Show me top 50 customers by week’.  
 



Understanding WhizAI User Interface 

 

 

265 of 315 

 

Switching between Period over Period (POP) to Year over Year (YOY) growth 

on cards in pinboards 

On period over period comparison (PoP) cards in pinboards, you can switch to year over year (YoY) 
comparison. For example, if you ask the query ‘Show me NRx, nbrx average by regions mtd pop’ you will 
get the response as shown in the following figure. 
 

 
 

To switch between POP and YOY growth, expand the card and click the hamburger button. You will then 

see a Period Operator toggle button that allows you to switch between the two. This is demonstrated in the 

accompanying figure. 

 Note! This toggle is available only when the card is pinned to the pinboard. 
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Exporting Pinboards to PDF or PPT 

1. From the main pinboard panel, open the pinboard you have to export. 

 

 
 

2. Click  icon to open the list of options and then click Export Pinboard. WhizAI shows a dialog 
where you can select individual pins to export to PDF, as required.  
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 Note! By default, all the pins are selected to be exported to PDF. If you want to export individual 
pins, you can clear the checkbox, as required.    

 

 Tip! You can select Landscape or Portrait orientation mode, as required. WhizAI creates the PDF 
according to the selected mode. 

3. From the Destination drop-down, select PDF or PPT, as required. 
 

4. Click Export. According to the option selected, a PDF or PPT file is downloaded to your local folder. 

 Note! You can export a pinboard if you are a board owner or even if you are a board viewer. 

 

 Note! WhizAI captures information regarding pinboard exports. The Admin user can track this under 
the Admin > Audit Logs section. 
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Moving pinboards across environments 

As a Board Owner, you can import or export a pinboard across environments. Let’s have a look at some 

details when you export a pinboard: As a board owner, you can see the option to Export the pinboard to 

any other environment, as shown in the following figure: 

 
 

After you export the pinboard, a JSON file is downloaded on your local machine that contains all the 

pinboard details such as the details of the pinned cards, metadata that is ‘locked’, visualizations, board 

level, and card level filters, etc. (This file is used during import to other environments.)  

 Remember! You can export a pinboard in its temporary state or the latest ‘saved’ state. 

 

 Tip! The export is captured as part of the Audit Logs under the Administration page.  

 

When you import a pinboard: As a board owner, you can see the option to Import the pinboard to the 

desired environment. The import is executed using the JSON file that is downloaded during the export 

pinboard activity. From the dialog box, select the JSON file or drag and drop it and click OK.  
 

 Tip! You can minimize the Import pinboard window and continue with your work. This import-
export activity is executed by the system without causing any impediments to your work.  
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In case a board with the same name already exists, you can either choose to import the board with a 

different name or you can allow WhizAI to override the existing board. In this case, although WhizAI 

overrides the board, it retains the sharing preferences of the original board. In case, a board is imported, 

however, the new environment does not contain the corresponding data model/s; in this case, WhizAI 

shows relevant messages to make you aware of the limited data availability. Tip! The Import activity is 

captured as part of the Audit Logs under the Administration page. 

From the pinboard navigator, you can download the pinboard from the current environment in JSON 

format and import the pinboard into the destination. This allows you to move your pinboards from one 

environment to another. 

Importing and Exporting a pinboard from Pinboard Navigator 
 

To download a pinboard in JSON format from the Pinboard Navigator: 

1. From the Pinboard Navigator, go to the pinboard that you have to export, and click the  . The 

option to export the board becomes available. 
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OR 
In case Pinboard Manager is configured for you, open the pinboard that you want to export as 

JSON format and click  icon and then click Export as JSON. 
 

 
 

2. Click the export button  next to Pinboard Navigator. You get the following message. 
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3. Click Got it! The pinboard gets downloaded in JSON format. 

 Note! WhizAI shows a dialog where it prompts the user that annotations and sharing 
preferences will not be exported as shown in the figure below. 

 

 Note! This feature is only available when Pinboard Manager is configured.  

 

To import pinboard in JSON format from the Pinboard Navigator: 

1. Click the  icon. The Pinboard Navigator is displayed. 
 

2. Click the import icon next to the Pinboard Navigator. An Import pinboard dialogue box is 

displayed. 
 

 

3. Click Browse files. Your file explorer window is displayed. 

 

4. Select the pinboard in JSON format you wish to import. Click Open. An Import pinboard dialogue 
box appears. 
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5. Click Got it! You get a message that the pinboard is imported successfully. 

Copying Pinboards 

1. From the main boards panel, open the pinboard of which you have to create a copy. 
 

 
 

2. Click  icon to open the list of options and then click Copy Pinboard. WhizAI shows the Create a 
Copy? dialog.  

OR 

In case Pinboard Manager is configured for you, open the pinboard that you want to copy and click 

 icon and then click copy. 
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3. Click Yes to create a copy of the pinboard. WhizAI creates a copy of the pinboard. 

 
 

 Note! You can copy a pinboard if you are a board owner, board viewer or a board editor. 

Scrolling on pinboards 

When there are filter/s added to pinboards, the filters toolbar gets hidden while scrolling up or down 

the board; however, the filters toolbar is displayed back on your screen as soon as you stop scrolling. 

Before scrolling on the pinboards the filters toolbar is displayed as shown in the following figure. 
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After scrolling on the pinboards the filters toolbar is hidden as shown in the following figure. 
 

 

Opening Pinboards from Explorer 

WhizAI now offers the ability to call specifically named pinboards directly from Explorer. All you must do is 

ask specific questions in Explorer and WhizAI opens the pinboard for you.  

For example, as a sales rep, you can ask the query: Show me the HCP preparation pinboard, then in this 

case WhizAI opens the corresponding pinboard. 

OR 

As a sales rep, you can ask Prepare me for my day for Boston MA; in this case, WhizAI opens the 

corresponding pinboard with ‘Boston MA’ applied as a filter. 

Opening Pinboards from Cards 

WhizAI gives you the ability to navigate to a pinboard directly from a card.  
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If you hover the cursor over any data value in a card, WhizAI opens a list of all the pinboards that are either 

created by you or shared with you. From this list, you can click the required pinboard to open it.  

Before opening that board, WhizAI filters the board data according to the data value clicked from that card. 

Thus, that board displays information related only to that data value. Also, you can see this data value set in 

the filters on the pinboard. 

Updating Data on Pinboards and Cards 

The data on cards and pinboards is updated automatically thus you can always view the latest information. 

 Note! If you are using the pinboards and the system is down, you shall continue to see the data on 
cards, however, WhizAI shows an error message notifying you about the system being down. Also, 
during the downtime, the ‘Apply’ button that you can see when applying filters after is unavailable.  

 

 Tip! If you Refresh your browser, you can update data on all the cards in a pinboard. 

Updating action fields on cards in pinboards 

On pinboards, certain cards can be configured so that they show an actionable metric column. 

You can update the actions performed against a particular record from the dropdown lists in this column. 

For example, if you ask, Show me top customers by status’: 

The response displays a Status column. When you hover the cursor over any field in this column, a tooltip is 

displayed asking you to select an action (No, Not Applicable, Yes) from the drop-down list, as shown in the 

following figure: 
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After you click Save, the updated actions get captured on the card. This helps collaboration between the 

board users as all the board users can view the updated action for a particular record/s. Also, the board 

users can edit the action, if required. 

Sorting on editable column for easy access to data 

The sort function for ‘editable metric’ columns allows you to perform certain actions such as updating the 
column values etc. Click the column names to sort the values. This facilitates quick access to the desired 
records.  
 

For example, if you click the Status column (actionable metric column) in the following card. 
• The first click sorts the column values in descending order. 
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• The second click sorts the column values in ascending order. 
 

 
 

• As a pinboard owner or editor you can save the sorting. This saved sort order is retained and 
displayed in the exported files (XLS/PDF/PPT). 

 

 Note! Pinboard viewers cannot save the sort order. 

 

 
 

• After sorting, if the actionable metric column (Status column) is hidden, the system retains the 
sorting for the rest of the columns. 
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 Note! The following features are not supported for the editable metric: 

• Rollup-drill down 
• Follow-on 

• Setting up an alert on any data point 
• ExplAIn & Narratives 

The following are the two prerequisites for the sort function to work: 
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• Configuring lookup values: When you are configuring the lookup values for the editable data, 
those values should be configured in such a way that the sorted keys will also sort the values. The 
way we are using the system for the editable data is that sorting happens on the keys column. 

 This is a sorted list: (descending order) 
 

Key Value 

1 No 

2 Not Applicable 

3 Yes 
 

This is an unsorted list: 

Key Value 

2 Not Applicable 

1 No 

3 Yes 
 

• Loading Entire Dimensionality Data: To see all the data in the response, including other columns 
such as "Customers," you need to ensure that the entire dimensionality data is loaded into the 
editable data source, even if some values in the editable data column are null. By including null 
values and loading the complete dimensionality data, you can ensure that all the relevant 
information is available for sorting and displaying purposes. For example, 
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Setting Reference Date for Pinboards and Cards 

You can add reference dates to pinboards and individual cards so that only the relevant information is 

displayed. To add the reference date, from the pinboard or card, click the + icon (Add filter) and then 

select Reference date. For example, consider the following scenarios:  

• Data sources: ‘Sales’ data source and ‘Calls’ data source (out of synchronization).   

• Cards on Pinboard 1 have data from only the ‘Calls’ data source, thus the reference date on all the 

cards is the same.  

• Cards on Pinboard 2 have data from ‘Sales’ data source and ‘Calls’ data source. In this case, if the 
reference date is set for ‘Sales’ data source, then the cards having call data might either show an 
error or show irrelevant data. In this case, a board owner/ editor can set a reference date for 
individual cards so that the data represented on each of the cards is correct. 

Setting a different Reference Date 

For multiple data sources, WhizAI allows you to select the applicable reference date for better analysis of 

data in a response.  

1. Open a card pinned to a pinboard in maximized view. 

2. From the top-right corner, click Show Filter and then click the calendar icon  to open the Select 
reference date dialog.  
 

 Note! In the Select reference date dialog, WhizAI shows the name of the data source along with the 
corresponding reference date.  

 

3. From this dialog, select the required reference date and then click Apply. 
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Slicers in Pinboards & Cards 

Slicers is a feature that allows you to save filters or a combo of filters, that you often use and have to 

frequently apply to pinboards. Thus, slicers eliminate the need to manually add such commonly used filters 

or filter combos every time you want to filter data. Slicers can be applied to pinboards and cards. You can 

create and add slicers to pinboards or individual cards within pinboards. To add slicers to cards, you may 

open the card in the maximized view and besides the ‘filters’ section, you can see the slicers icon. Applying 

a slicer to card/s overrides the existing filters or slicers. Also, please note that slicers are the same 

throughout. You cannot have different slicers for cards and pinboards. 

 Tip! For a card, if you create a slicer that contains ‘locked’ metadata, WhizAI ignores the ‘lock’ and 
treats the slicer as a usual filter.  

 

 Remember! Slicers are not saved for a particular pinboard, they are grouped under a particular data 
source.   

When you apply slicers to boards or cards, WhizAI merges the slicer values with (existing) filters applied to 

the board or card. Whenever the slicer is applied on a board or card, only those slicer values that are 

common to the board or card are applied. For example:  

• Slicer1: Brand= Zocor, Region=West, HCP=ABC  

• Board/ card filters: Brand=Crestor, Region=East, Account= XYZ 

In this case, after you apply Slicer 1, the new filters on the board are as follows: Brand=Zocor, 

Region=West, Account=XYZ.  

 Note! The slicer values that are not present on the board/card are not considered and applied. In 
the above example, the HCP slicer value is not applied on the board/card. 

 

 Remember! Not always the entire slicers are applied. In the slicers window, you can see the 
following message: “Only the slicer context matching the board/card context is applied “. The message 
is visible only when there are no slicers in the list. 

When you apply a slicer, the cascaded values present in that slicer are preserved on the board or card. If the 

cascading sequence is disturbed after the slicer is applied, for example, Slicer: District=New England and 

Board: Region=Midwest, District: Mountain, Territory: Chicago IL, in this case, all the remaining values i.e. 

Region and Territory in the cascading must be reset i.e. set to 'All'. 

Creating a slicer 

1. Open the pinboard and click show filters, WhizAI shows the slicers icon as soon  
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2. Click the slicer icon and then click Create new slicer + . WhizAI shows the Create slicer dialog to 
add the filter combo as a new slicer.  
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3. Optional: You can click + to add more filters if required.  
 

4. Click Save to add the slicer. 

 

 

 

Creating static slicers from responses on Explorer  

WhizAI supports creating static slicers on the fly from responses on Explorer and Pinboards. Wherever there 

is a response that has at least one row dimension available, you can create a slicer. This allows you to group 

a set of dimension values and track them for the analysis. You can create slicers for the following applicable 

responses. It is applicable for all table responses except single datapoint & multi-data point responses 

Slicer creation flow 

1. Input the NLQ for a table response. For example, Top Regions by Trx. 
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2. Go to the burger menu > Create slicer. A Create slicer dialogue is displayed. 
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3. Click + to modify the slicer (optional). Add Filters dialogue is displayed. 
 

 
 

4. Select the filters and click Save. You are re-directed to Create-slicer dialogue. Click Save. 

 Note!If the slicer name already exists, then an error message is displayed. 
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5. The slicer is displayed under the slicer menu on Explorer and Pinboard as shown in the figure below 
 

 
 

Sharing of Slicers from Explorer and Pinboard 

WhizAI provides the ability to share slicers with users. This enhancement improves data analysis speed and 

reduces redundant slicers. 

Follow the steps given below to share the slicer from Explorer or Pinboard: 
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• From the top-right corner of the Explorer > slicer icon  > select the slicer you wish to share > 

click share icon . 
 

 
 

• The Share slicer with dialogue is displayed. You can share the slicer either with single or multiple users 
or groups. You can also add a note as shown in the figure below. 

 

• Click Share. You will receive the notification under the bell icon  . 

Editing a slicer  

1. Click the slicer icon. WhizAI shows the list of available slicers.  
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2. Hover the cursor over the slicer you want to edit.  
 

 

 
 

3. Click the edit icon. WhizAI shows the Edit slicer dialog.  
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4. You can change the filter values or add filters to the slicer and click Save. WhizAI saves the changes. 

Deleting a slicer 

To delete a slicer, hover the cursor over the slicer and click the Delete icon. 
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Cohorts in Pinboards and Cards 

Cohorts allows you to group values of a dimension that share the same characteristics to analyze your 

patient and customer data. 

WhizAI creates cohorts on the fly from the slicer and cohort  icon on Explorer and Pinboards. 

This allows you to group such values with certain conditions having a single target dimension. The condition 

is built using AND logic between one or more conditions with In and Not In operators to select the values. 

Cohorts is used for group analysis for a specific dimension.  

 

One of the simple use cases of cohort is by grouping customers based on demographic information such as 

age, location, or gender. Examine the cohorts on how different demographic groups interact with your 

product and tailor marketing strategies accordingly.  

 

Note! The same dimension cannot be used multiple times in the condition builder. 

Cohort from Explorer 

• Click Slicer and Cohort icon  > Cohorts > Create new Cohorts +. Create a new cohort 

dialogue is displayed. 

 

 
 

• Add Cohort name and Description. Select the target dimension from the drop-down. The target 

dimension serves as the basis for grouping entities into cohorts. 

 

•  Click +Add Condition. Select the Dimension, Operator (In, Not In), and  Values from the drop-

down. You can add another condition using AND logic. Click Save. 
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 Note! Save option is enabled only when conditions are added. 

 

 

• A message is displayed on the “Cohort was created successfully” 

 

 
 

• To view this cohort, click  > Cohorts > All > Cohort.  

 Note! The cohorts are displayed in three different tabs namely All , My List and Shared 
with me. All tab include the entire list, My List tab displays the cohorts created by you, and Shared 
tab lists the cohorts shared with you. 
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Managing Cohorts 

As an owner or editor, WhizAI allows you to Share, Copy, Edit, or Delete the cohorts from the explorer or 

pinboard. A system notification is sent to all the recipients if the cohort is shared or unshared by the cohort 

owner.  

Note! While editing the cohort, changing the target dimension is not allowed. 

After updating/ editing the cohort the changes are propagated to all the recipients on hard refresh or for a 

new session. 

 

Sharing Cohorts 

Cohort Sharing behavior - Authorization criteria:  

Individual user: Authorization is checked when the cohort is shared with an individual user. 

Group Sharing: No authorization check is performed for individual group members at the time of sharing. 

However, when a user queries the cohort with natural language queries (NLQ), authorization is checked, 

and data for unauthorized dimension entities are not displayed. 

Metric Access: At least one metric must have complete access to all the dimension entities selected in the 

filter conditions of the cohort. 

Scenario: Cohort Sharing from User1 to User2 

1. Authorization Check for User2: 
• Hidden Dimension: If the dimension "Customer" is a primary dimension or filter condition at any 

level in the cohort: 
o Customer: If this dimension is unauthorized for User2, the cohort will not be shared. 
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2. Example Authorizations for User2: 
• All metrics: 

o Region: Mid-Atlantic, Mid-Central 
o Age Group: 19-30 

• Trx metric: 
o Region: West 

 

3. Cohort Details: 
• Primary Dimension: Customers 

Case 1: 

• Filter Conditions: 
o Region: Mid-Atlantic, Mid-Central 
o Age Group: 19-30 
o Gender: Male, Female 

• Outcome: The cohort will be shared since User2 has authorization for all specified regions and age 
groups. 

Case 2: 

• Filter Conditions: 
o Region: Mid-Atlantic, Mid-West 
o Age Group: 19-30 
o Gender: Male, Female 

• Outcome: The cohort will not be shared, as the Region "Mid-West" is unauthorized for User2. 

Case 3: 

• Filter Conditions: 
o Region: West 
o Age Group: 19-30 
o Gender: Male, Female 

• Outcome: The cohort will be shared since the Region "West" is authorized for the "Trx" metric. 

 

Sharing a Cohort 

Follow the steps given below to share, the cohort from Explorer: 

• From the top-right corner of the Explorer > Slicer and Cohort icon  > Cohort tab  > select the 

cohort you wish to share > share . 
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• The Share cohort with dialogue is displayed. You can share the Cohort either with single or 
multiple users or groups. You can also add a note as shown in the figure below. 
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• Click Share. You will receive the notification under the bell icon  . 

Editing a Cohort 

Follow the steps given below to edit the cohort from Explorer: 

Limitation: When the user is authorized, the unauthorized dimension is displayed on the tooltip of the 
shared Cohort. 

• Click the slicer icon  > Cohort tab  > select the cohort you wish to edit > edit . 

 

 

• The Update Cohort dialogue is displayed. You can update the name, description, and/or conditions 
of the cohort if you are the owner. Click Save. Changes made are propagated to all the recipients of 
the cohort when hard refreshed.  

 Note! To update the target dimension option is disabled.  
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Copying a Cohort 

Follow the steps given below to copy the cohort from Explorer: 

• Click slicer and cohort icon    > Cohort tab  > select the cohort you wish to copy > copy . 

 

 

• You are redirected to Create new cohort dialogue. Update the Cohort name and/or conditions and 
click Save. 
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• A message is displayed on the explorer “Cohort was created successfully” 

 

• To view this cohort, click  > Cohorts > Cohort 2. 
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Deleting a Cohort 

Follow the steps given below to delete the cohort from Explorer: 

• Click slicer and cohort icon  > Cohort tab  > select the cohort you wish to delete > delete . 

 

 

• WhizAI confirms whether you want to proceed with the action. Click Delete.  
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Using Cohorts on Pinboards 

As a board owner, you now have the ability to apply cohorts on pinboards, enabling collective group 
analysis of the cohort. The cohort filter always gets precedence over other filters.  

 Important! If filter values conflict with cohort conditions, the filter values are reset according to 
cascading rules. Only values that are compatible with the cohort filter are displayed. 

 

 Important! If a second cohort is applied to the pinboard the cohort will always replace the already 
existing cohort on the pinned card irrespective of whether the target dimension is the same or not. 

 
 

 Note! Spotlighting does not get applied directly to a cohort filter. However, if spotlighting is applied 
to a filter after the cohort filter has been applied, it will highlight the filtered values within the already 
filtered cohort data. 

 

To add cohort filter on pinboards, follow the steps as below: 
1. Click the ' Add Filters ‘+’ icon on the pinboard. The Add filters dialogue is displayed. 
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2. Select the Cohorts filter and click Save. The Cohorts filter gets added to the pinboard. 
 

 
 
3. Select the Cohort value from the drop-down.  
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4. Click Apply. Cohort is applied to all the cards on the pinboard. 

 
 

 
  

5. Add a Customer filter. Only the values available for Cohort is displayed.  
 
 

 
 

 
6. Select the value and click Apply and Save Changes 

 

 

Annotations in Cards 

WhizAI allows you to add annotations or notes at different points in a chart or cards having tabular data. In 

any type of chart response, from the bottom left side corner, you can click Show Notes to enter the 
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annotations mode. When you enter this mode, you can click any data point to add additional information or 

notes to it. You can click Hide Notes to opt out of the annotation mode.  

 Remember! The Show Notes button is available only for the ‘Charts’ and ‘tabular’ response types. In 
other types, you shall not see this button.  

 

 Remember! The annotations are bound to the data points irrespective of the visualization pattern. 
Thus, if you add annotations to one type of visualization pattern and then view the same card in a different 
pattern, WhizAI retains these notes and displays them at the same data points.   

 

If you are a board owner or a board editor, you can: 

• Add or edit your annotations 
• Reply to the notes added by other users 

• Delete the notes added by other users 

Also, as a board owner, you can delete replies added by other users. Whereas, if you are a board editor, 

you cannot delete these replies. As a board viewer, you can add and reply to annotations, only.   
 

 Note! If you update the data on a card by adding filters, WhizAI does not show the annotations on 
the updated chart response. 

Also, you can add annotations to cards having tabular data. From the pinboard, open the card having 

tabular data in maximized view, you can see a Show notes icon at the bottom of such cards, as shown in the 

figure below:  
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If you click this icon, you can see a notes icon as you hover over the table rows. Click any row to add 

annotations to it. A ‘temporary’ state of a pinboard is when a board owner or a board editor adds filters to a 

pinboard to view the updated data in pins; however, does not save these changes. In this 'temporary' state, 

if you add annotations to cards, they are not visible to any other user with whom the board is shared, 

instead, you see a warning message. 

 Note! The warning message stays till the pinboard is in the ‘temporary’ state. It goes away when you 
save the change. 

Adding Annotations 

1. From the pinboard, open the card to which you have to add annotations. 
 

 
 

2. From the bottom left corner, click Show notes. WhizAI allows you to add annotations to the chart. 

You can see the note at the bottom of the card as shown in the following figure: 
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3. Click any data point to add annotations to it.  
 

 
 

4. Enter notes in the dialog, as required, and then click Add Notes to save the details. WhizAI adds the 

notes at the data point as shown in the following figure: 
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5. Click Hide notes to opt out of annotations mode.  

Editing Annotations  

1. Open the card and from the bottom left corner, click Show notes to enter the annotations mode. 
 

2. Open the annotation that you want to edit.  
 

3. Click Edit. WhizAI allows you to edit the details, as shown in the following figure: 
 

 
 

4. Update the details and then click Save.  
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5. Click Hide notes to opt out of annotations mode.   

Deleting Annotations 

1. From the pinboard, open the card to which you have added annotations and want to delete it. 
 

2. Click Show notes to enter the annotations mode, then open the annotation that you want to delete. 
 

3. Click Delete. WhizAI shows a confirmation message.  
 

4. Click Yes to delete the annotation. 

Sharing Pinboards and Cards 

After successfully Creating a Board, follow these steps to share that pinboard with your team member or 

entire groups of members, as required: 

1. From the main board’s layout page, click  icon and then click Share. WhizAI opens the Share 
Board dialog with a list and groups of your team members. 
OR 
In case Pinboard Manager is configured for you, open the pinboard that you want to share. Click 

 icon and then click Share. 

 

 
 

2. To select the members, click “+”, or search by entering their name or email.  If you want to share the 
pinboard with groups of users, click Groups and select the groups of team members, as required.  
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3. Optional: If you want to assign editing rights to the user, from the drop-down list, select Edit as 
shown in the following figure: 

 

 

  
 

 Note! As a board owner, you may choose to assign Editing rights to the users with whom you 
are sharing the board. If these rights are assigned, the board editor may choose to make a copy of 
the board, export the pinboard to PDF, or unfollow the board, as required.  

 

4. Click Save. The board is shared with the selected members or the group. Selected members will get 
a notification on their Explorer. For more information about notifications, see Notifications. 

 Note! When someone shares a board, you receive a notification about it in the form of a 
clickable link. You can click that link to open the shared pinboard. 

 

 Note! If someone shares a pinboard with you and you do not have access to view the details 
in a card/s within that pinboard, in this case, WhizAI shows a message that says “Sorry, you are not 
allowed to see the data for <Dimension Name>” when you open that card in maximized view. 

 

There are two ways to share cards from pinboards:  

1. From the board that is open in Explorer, go to the card that you have to share with other users and 

then click More Options.  
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 Note: The ‘Share’ option is only available to board editors and board owners if the card-
sharing feature is enabled for the environment.  

2. Click Share. WhizAI shows the Share response with dialog.  

 
3. You can search for the user or select the user from the list. If you want to share the card with groups 

of users, click Groups and select the groups of team members, as required. Then click Share to 

share the card with the selected user/s.  

OR 

Open the card that you want to share from the top-right corner and click . 

 

 
 

 Note: The ‘Share’ option is only available to board editors and board owners if the card-sharing 
feature is enabled for the environment.  

4. Click Share. WhizAI shows the Share response with dialog.  
 

5. You can search for the user or select the user from the list. If you want to share the card with groups 

of users, click Groups and select the groups of team members, as required. Then click Share to 

share the card with the selected user/s. 



Understanding WhizAI User Interface 

 

 

309 of 315 

Sharing Pinboards and Cards with User Groups 

You can share pinboard/s with system-generated group/s of users. To share a pinboard with a user group: 

Go to the pinboard and click the + button to share it. From the Share Board dialog, go to Groups and then 

select a user group, as required. Click Save to share the board. 

 
 

 Note! If you are a member of a particular group and a pinboard is shared with that group, then, you 
cannot 'unfollow' that board. 

 

A typical system-generated group contains users categorized based on their roles, for example: you may 

see a user group of MRs or a user group of Sales Reps, and so on.  
 

 Remember! The admin users can track all the activity pertaining to user groups. For more 
information, see the Audit Logs section. 

Stop following a pinboard 

1. From the main board’s layout page, open the pinboard that is shared with you.  
 

2. Click  icon and then click Unfollow Pinboard. WhizAI shows a confirmation message. 
 

3. Click Confirm to stop following the board. WhizAI displays a success message. 

Transferring Ownership of Pinboards 

If you are a board owner, WhizAI allows you to transfer ownership of that board, that is, you can set a new 

owner for the board. As shown in the following figure, you can click Transfer Ownership to select a new 

owner for the pinboard. Remember! You do not share the board ownership with the new user. After the 

ownership is transferred, you become the board viewer. To transfer the board’s ownership: 
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1. Open the pinboard whose ownership you must transfer to any other user. 
 

 

2. Click  icon to open the list of options and then click Transfer Ownership.  
OR 
In case Pinboard Manager is configured for you, open the pinboard whose ownership you want to 

Transfer to other users. Click  icon, and then click Transfer Ownership. 
 

 

 
 

3. WhizAi shows the Transfer Ownership dialog. Select the user to whom you must transfer the 
board’s ownership and click Share. WhizAI shows a confirmation message.  
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4. Click Yes. WhizAI transfers the ownership of the board to the selected user.  

Removing Pinboard sharing  

You can discontinue the sharing of your board from all users or specific users.  

1. From the Explorer, click Pinboard Navigator > Pinboard Manager >  All Pinboards to open the 

main board’s layout page.  

2. Open the board that you want to stop from being shared with others. 

3. Click the  icon and then click Share to open the Share Pinboard dialog. This dialog shows the 

user/s with whom you have shared the pinboard.  

4. Clear the check mark for the team member with whom you want to discontinue the sharing. If the 

board is shared with a particular group, go to the Groups tab, and clear the check box against that 

group. 

5. Click Save. WhizAI shows a success message, the board is removed from the board panel of the 

respective users and/or user groups. 
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Switching base metrics on cards 

On pinboards, for cards with a common base metric having computation/s, if you switch the base metric by 

applying filters then the base metric gets changed and computations from the previous metric remain the 

same.  
 

For example, when you ask WhizAI ‘Show me TRx growth and Trx market share by customers’ then you get 

the response for the metric TRx for the computations Growth and MarketShare as shown in the following 

figure. Now, if you change the metric TRx to NRx, then the base metric for Growth TRx and TRx MarketShare 

will change to Growth NRx and NRx MarketShare. 
 

 
 

Only the metric TRx will get changed to NRx for computations Growth and MarketShare as shown in 

the following figure. This helps in maintaining a single card for the base metrics which have common 

computations. 
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Renaming Cards from Pinboards 

1. Open the card and click the title of the card to rename it. WhizAI allows you to change the name of 

the card as shown in the figure below. 
 

  
 

2. Rename the card, as required, and then click Save to apply the changes. Click Reset to undo the 

changes. 

Viewing Cards in Full Screen Mode 

When you open the cards pinned to a pinboard in a maximized view, you can click this icon to make the 

display full screen. 

 

Deleting a card from a Pinboard 

1. Click   and thn click Designmode. Go to the card which you must delete. 

2. Click   and then click Delete as shown in the following figure. WhizAI deletes the card from the 

pinboard: 
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Deleting a Pinboard 

1. Go to the pinboard that you must delete. Click  icon to open the list of options and then click 

Delete. WhizAI shows a confirmation dialog. 

 

OR In case Pinboard Manager is configured for you, open the pinboard that you want to delete, click  
icon and then click Delete. 

 
From the confirmation dialog, click the Delete button. The board will be deleted from Explorer. 
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